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Introduction 

About PrintSmith Vision  

PrintSmith™ Vision is a browser-based print management system for commercial printers, trade printers, copy 
shops, and quick printers. To help you run your business efficiently and profitably, PrintSmith Vision combines 
estimating, invoicing, billing, point of sale, and accounts receivable in a single product. 

 
PrintSmith Vision supports commercial printers, trade printers, copy shops, and quick printers. It provides the 
features needed in commercial printing (like support for web presses, digital presses, and large format presses) 
without requiring that you use or understand features that do not apply to your business. As your business grows 
and changes, however, PrintSmith Vision is flexible enough and powerful enough to grow with you. 

 

About Estimates and Invoices  

Estimates are quotes you give to prospective customers indicating what you will charge for the work they want 
you to perform.   

Invoices show the actual price of the job and then serve as a bill for the work you performed. 

  

Note Because estimates and invoices in PrintSmith Vision are so similar, this manual often uses the 

term document to refer to them.  

An estimate or invoice may include more than one job, and typically also includes some charges related to the 
work involved, for example, a charge for design work, ink, cutting, or boxes.  

In many situations estimates are unnecessary. If you know you have the job, you can just create an invoice for 
the customer. For complex work, however, estimates help you determine an accurate selling price as well as 
give you a way of submitting bids based on different quantities and different stock. If the customer accepts your 
quote, you convert the estimate to an invoice, meaning the estimate is won; If the customer rejects the quote, the 
estimate is archived (as part of the customer’s estimate history) and considered a loss.  

Tip  For small simple jobs, you can use POS (point of sale) in PrintSmith Vision to record a sale and print out 

a cash register style receipt. In this case, you typically bypass invoices altogether since the cost of 

preparing the invoice could exceed the amount of the order.  

The content of estimates and invoices is very similar, as is the procedure for creating them. Estimates and 
invoices each have their own numbering system, however, and they are handled differently in the system.  

Warning  If you use pre-printed forms for your estimates or invoices, they should not be numbered; PrintSmith 

Vision automatically assigns numbers to both estimates and invoices.   

Accurate estimating is a key part of the sales cycle. In PrintSmith Vision, you can create a simple quote quickly, 
as well as perform sophisticated estimating when you are bidding for jobs.  
PrintSmith Vision comes with a completely defined pricing system with definitions and functions for everything 
from prepress to packaging. This pricing system can be adapted to your business so you are not defining the 
system from scratch.  

 
You can price products, services, or materials using any combination of pricing methods such as flat rate, cost 
plus markup and/or rate, hourly rates, variable markups, and price lists. You can use the pre-press and bindery 
charges supplied by EFI, adapt them, or create your own. Likewise, you can use or adapt the stock, press, digital 
definitions, and price schedules supplied by EFI or create your own.  

About Cash Register 

If your shop does walk-in business that does not require invoices, you record the work and payment for it in the 
Cash Register window. You can use this window for any work that does not require an invoice. 
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Cash Register in PrintSmith Vision provides all the functions you normally expect of a dedicated cash register. 
You can enter sales and payments, keep a record of each transaction, print receipts, process credit cards, and 
open a cash drawer.  

Note Integrated credit card processing, the cash drawer, and the receipt printer are optional purchases.  

Because the cash register is part of PrintSmith Vision rather than a dedicated machine, PrintSmith Vision can 
provide a detailed breakdown of each transaction by date/time, the person who performed it, what was done, and 
the account to which the transaction was posted. If you have an external cash register, you can use POS to enter 
the totals from the register into PrintSmith Vision; this information then becomes part of the detailed sales 
analysis that is typically performed each day.  

Even if you have no need for a cash register, the cash register program serves as a link between estimating and 
accounts receivable by tracking each estimate and the status of all jobs in progress and those awaiting pickup or 
delivery. When an invoice is delivered to a customer and picked up in PrintSmith Vision, it is automatically posted 
to accounts receivable and added to the full account history for each customer. 

 

About Post Payments 

When you post invoices and charge them to an account you are creating an account receivable for that account. 
When the customer pays what was charged, you must apply the payments against the invoices so they are 
recorded as Accounts Receivable receipts. This process reconciles the money you received with the money that 
was due (as recorded in your invoices). In PrintSmith Vision this is known as posting payments.  

Why posting payments is important  

A common mistake when first getting started with PrintSmith Vision is to enter payments while picking up 
invoices without applying them to invoices. This has some undesirable side effects:  

• Invoices that were paid are still shown as open and may cause the account to become past due when it 
really is not.  

• Customers may not understand statements that include invoices they think they paid.  

• The receipt is considered “on account,” and is not included as a taxable cash receipt in Accounts 
Receivable.  

About Journal Entries  

A journal entry is a new transaction that counteracts or reverses the original transaction. Journal entries result in 
debit or credit memos. They are used to adjust the total due on an invoice, add or remove tax from an invoice 
after posting, write off bad debts, adjust account balances, and so on. 

 

About Register Tape  

PrintSmith Vision keeps a detailed record of all transactions for each sales “day” on an electronic register tape. A 
sales day ends when you perform a closeout and a new tape is started. The register tape records significant 
events such as deposits, document voids, posted payments, finance charges, and journal entries. When you 
post transactions in the Cash Register window they are recorded on the register tape.  

About Closeout 

A closeout in PrintSmith Vision is the process of summarizing the sales and accounting activity for a day or 
month. They can also be set up to do manually or automatic. 
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About Pending Documents 

  
When you first create a new document, PrintSmith Vision puts it on the pending list. This list includes all the 
“active” invoices and estimates in your shop and is displayed in the Pending Documents window. This window 
is your “command center” in PrintSmith Vision for working with active documents. 

 

Tip  You can also view a summary of the pending list from a mobile device. 

 

Eventually, each document in the Pending Documents window is removed as follows:   

• You convert estimates to invoices if you get the job, or void (cancel) or archive them if you do not get 

the job. You can track archived estimates in estimate history.   

• As work on invoices is completed, you pick up the invoices and indicate they were paid. You can track 

picked up and paid invoices in the history that PrintSmith keeps for accounts.   

The documents in estimate or account history are “locked” since they form part of the audit trail PrintSmith 
Vision maintains. All details in the document are retained, however, and you can copy these documents to new 
estimates or invoices. You can update the pricing with the latest prices when you copy a document, but all the 
descriptive information and notes you made on the job (the location and condition of the artwork, special 
pricing instructions, and so on) are retained.  

When you copy a document from history, PrintSmith Vision keeps track of the source document. For example, 
the old document number is displayed in the document window and printed on job tickets. If you file artwork by 
document number, and get a repeat order, the job ticket has the old document number so you can locate the 
artwork.   

About Web Product Templates 

Web products templates are set up under the Template section. You can create web product templates and map 
them to Digital Store Front products. When your customer purchases a DSF product the information from that 
mapped template is used to create an invoice document. 

 

About Purchase Orders and PO History 

Many jobs require items such as paper or ink that you must purchase. To help you manage the purchasing 
process, you can create purchase orders in PrintSmith Vision for the kinds of supplies or outside services that 
you typically need for the jobs you produce. Purchase orders can be created in the Invoice program and in PO 
history. 

The PO history will show you the current and closed purchase orders. Here you can view a specific purchase 
order and modify or change the status. There are several column headers that can be used to filter or search 
for purchase orders. 

About Quick Access Panel 

Quick Access panel not only provides shortcuts to your most commonly used features, it provides a view of the 
status of orders taken by the logged in user or for the entire plant. Quick Access includes:  

• Estimate, invoice totals and total orders for the previous day and current day.  

• Year to date and month to date totals of orders, sales, and journal entries.  

• Lists of invoices due today, overdue, and optional custom field. 

• A list of estimates still in a pending state, with the ability to open and review them. When an     estimate 
is open, you can convert it to an invoice so you can go ahead and produce the job and bill the customer.  

• A log of the communication that has taken place with customers, with the ability to follow up on issues.  
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About Work in Progress 

Work in Progress displays the open jobs or documents. There are several options to filter the documents 
including those that are outsourced and for Fiery production. You can set up new filters or use the ones already 
setup based on due date. The jobs and documents can be set up by color to identify past due, pickup ready, hold 
or those with a firm wanted by date. 

From here you can access the jobs and documents and see the detail. You can also send jobs to Fiery 
production if that is part of your workflow. 

PrintSmith Vision: EFI-Hosted vs. Customer-Hosted  

PrintSmith Vision can either be hosted by EFI (cloud-based) or hosted by you at your facility.  

EFI-hosted  

When EFI hosts PrintSmith Vision for you, PrintSmith Vision is installed on a server in the EFI hosting center, not 
in your facility. This cloud-based option means that EFI takes care of the hardware and software infrastructure for 
you, as well as the installation of PrintSmith Vision, updates, backups, and so on.  

 

Customer-hosted 

 
If you are hosting PrintSmith Vision, the PrintSmith Vision server is at your facility, so you control the hardware 
and software infrastructure and are responsible for installing and updating PrintSmith Vision, performing 
backups, and so on.  
Most PrintSmith Vision procedures are the same whether EFI is hosting PrintSmith Vision or you are hosting it, 
but some procedures are different and some apply only to EFI-hosted or only to customer-hosted installations. 
PrintSmith Vision - EFI-Hosted Guide explains what is different in EFI-hosted installations. If EFI is hosting 
PrintSmith Vision, be sure to use this guide together with other guides like this PrintSmith Vision – Setup and 
User Guide. Other guides will indicate when a feature or procedure applies only to customer-hosted installations 
(not EFI-hosted). 
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Contact Information 

 

EFI Support 

Web Site: https://customer.efi.com/support 

US Phone: 
1.855.EFI.4HLP 

480.538.5800 

UK Phone: +44 (0) 800.783.2737 

EU Phone: +49.2102.745.4500     

E-Mail: Printsmith.support@efi.com 

Regular US Service Desk hours are 7 A.M. to 5 P.M. Mountain Standard Time, Monday – Friday 

Regular UK Service Desk hours are 8 A.M. to 5 P.M. Greenwich Mean Time, Monday – Friday 

Regular EU Service Desk hours are 9 A.M to 6 P.M. Central European Time, Monday – Friday   

Outside of these hours, you may leave a voice mail message and an on-call support representative will be 
paged. Response time is based on the severity of the issue.8 

Note For problems involving infrastructure (i.e., computers, networks, operating systems, backup software, 
printers, third-party software, etc.), contact the appropriate vendor. EFI cannot support these types of 
issues. 

EFI Professional Services 

US Phone: 651.365.5321 

US Fax: 651.365.5334 

US E-Mail: ProfessionalServicesOperations@efi.com 

Outside US E-Mail: EMEAProfessionalServicesOperations@efi.com 

 

EFI Professional Services can help you perform EFI software installations and upgrades. This group can also 
help you implement, customize, and optimize your EFI software, plus offers a range of training options. 

 

  

https://customer.efi.com/support
mailto:Printsmith.support@efi.com
mailto:ProfessionalServicesOperations@efi.com
mailto:EMEAProfessionalServicesOperations@efi.com
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System requirements 

PrintSmith Vision Server Requirements  

You can install PrintSmith Vision on a Windows or Macintosh computer as long as it meets the requirements 
listed below.  

Important   Although you can run PrintSmith Vision on a shared server, EFI strongly recommends a 
dedicated server. Not only does performance degrade when several applications run on the server, but issues 
resulting from conflicting applications can be very difficult to diagnose. This type of diagnosis is therefore not 
supported by EFI.  

PrintSmith Vision can run on a virtual machine (VM). While EFI supports PrintSmith Vision running in a virtual 
environment, EFI is not responsible for your virtual environment or its setup. EFI will use commercially 
reasonable efforts to investigate potential issues with PrintSmith Vision running on a virtual machine, but as part 
of that investigation, EFI may require the issue to be reproduced independently of the virtual machine 
environment. When issues are confirmed to be unrelated to the virtual environment, EFI will support PrintSmith 
Vision in a way that is consistent with the support provided when PrintSmith Vision is running in a non-virtual 
environment.  

 

Windows 64-Bit  

   
Important   * If you currently use PrintSmith Vision and want to upgrade to Windows 10, be sure to 
follow the instructions under “Windows 10 and existing PrintSmith Vision installations” in the PrintSmith Vision - 
Release Notes. 

 

Macintosh 

   
Important  * If you currently use PrintSmith Vision and want to upgrade to OS X 10.12, be sure to follow the 
instructions under “OS X 10.12 (Sierra) and existing PrintSmith Vision installations” in the PrintSmith Vision - 
Release Notes 
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Important Notes About the Server  

• If PrintSmith Vision is going to be run from other computers (clients), the server computer should have a 
static IP address. This IP address is part of the URL users enter to run PrintSmith Vision; if the IP 
address keeps changing (because it is not static), the URL will also keep changing.  

• In addition, the server computer must be configured not to go to sleep. If the server goes to sleep, users 
who are running PrintSmith Vision from other computers will get a “server down” message and will be 
unable to use PrintSmith while the server is in sleep mode. On a Windows computer, turn off sleep 
mode in the Power Options settings in the Control Panel; on a Macintosh, turn off sleep mode in the 
Energy Saver settings.  

Client Requirements 

PrintSmith Vision Client Requirements (one on which PrintSmith Vision is not installed) are:  

• Operating system: Windows 7, 8, or 10  

• Macintosh OS X 10.13 (High Sierra) or higher  

• Memory: 4 GB minimum (more memory will improve performance)  

Browser Requirements 

OS  Browser Browser Version Comments 

Windows 10 
Professional 

 

Windows2008 R2 
Standard 

Google chrome 
Version 
69.0.3497.100  (64-bit) 

Certified 

 Mozilla  
 
62.0.3 (64-bit) 
 

Certified 

 Microsoft Edge 42.17134.1.0 

 
  Certified 

Mac OS 10.13  

(High Sierra) 

 

Safari 

 
12.0 (13606.2.11)  

 
         Certified 

Chrome  
Version 65.0.3325.181 
(64 bit) Certified 

iOS 11.0.3 (15a432) 

iPad 

Safari 11.0 (13604.1) Certified 

Chrome 62.0.3202.60 Certified 

Monitor and Resolution Requirements 

PrintSmith Vision is designed to be viewed and used on a large monitor with high resolution: 

• 19-inch monitor  
• Minimum resolution of 1280 x 1024  

Note:  Important If you are using a laptop, to see estimates and invoices in full, the height (second number) must 
be at least 1024 pixels. 
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PrintSmith Vision Basics 

How PrintSmith Vision Works  

The computer where PrintSmith Vision and its database are installed is known as the server. If EFI is hosting 
PrintSmith Vision for you, the server is in the EFI hosting center; if you are hosting PrintSmith Vision, the server 
is at your location.  
To run PrintSmith Vision, you use a browser from a client computer. For information about supported browsers 
and client computers, see the PrintSmith Vision – Release Notes or the PrintSmith Vision - Installation and 
Upgrade Guide.  
 
Important When PrintSmith Vision is customer-hosted, the server computer must be configured not to go to 
sleep. If the server goes to sleep, users who are running PrintSmith Vision from other computers will get a 
“server down” message and will be unable to use PrintSmith while the server is in sleep mode.  
When PrintSmith Vision is customer-hosted, you can also run PrintSmith from the server itself. 

Keyboard Shortcuts 

If you like to use the keyboard to accomplish tasks, several keyboard shortcuts are available. A keyboard 
shortcut is a combination of keys that you press at the same time, for example, CTRL+C means you press the 
CTRL key and c at the same time.  
 
Note  On a Macintosh computer is the equivalent of CTRL on a Windows computer, and OPTION is the 
equivalent of ALT.  

 

When a keyboard shortcut is available for a command on a menu, it is displayed next to the command, for 
example, CTRL+ALT+I for Invoice > Create Invoice. 

 

Here is where you can logout or go to the Legacy UI version. When you go to the Legacy version from the HTML 
5 version it will open in a new window, which will allow you to tab from one version to the other. 
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Searching 

For each program there is a search feature. You can search for different documents by using the dropdown. 

 

Navigation 

 

When you see three dots in the program it indicates that there is more than one option listed there. 

Any field that is underlined is editable. 
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This navigation panel is displayed in each application and allows you to access the other applications. 
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Accounting 

1. Accounts receivable 

• Post Payment (See page 95) 

• Journal Entry (See page 98) 

• Register Tape (See page 104) 

• Closeout (See page 106) 
2. POS (Point of Sale) 

• Cash Register (See page 88) 

Settings 

1. Template List (see page 17) 
2. Email Template (see page 21) 
3. Table Editor 

• Vendor (see page 24) 
4. Preferences 

• CardConnect® Setup (see Document PrintSmith Vision CardConnect®) 

• Credit Card Manager (see Document PrintSmith Vision CardConnect®) 

 

Template List 

Templates List will display all existing templates. The list includes Invoice, Estimated, Job and Product 
templates. Product templates are handled differently and will be discussed in another section. For information on 
Product Templates see page 18. 

You can narrow the search to just a type of template by selecting the appropriate icon across the top of the page 
or you can choose to view all templates.  

Note the quantity of templates in the all tab does not include the number of product templates. 

  

Invoice, Estimate and Job templates are all handled the same way. You have the same filtering options and the 
same processes. You can filter this templates by using any of the column headers. Just start typing and the 
program will filter the templates. You can also change the direction the templates or displayed by using the icon 
in the upper right-hand corner of each column heading field. Using the 3 dots you also have the option of 
duplicating or deleting the template. From here you can create template categories. 

Template Category 

If you select Template Category you will be taken to a screen that list the categories. Here you can search for a 
specific category using the columns at the top. Also, you can delete or duplicate the categories using the three 
dots next to the check box. As with other column headers you can search or sort the information. 

Create 
New 
Product 

Template 
Categories 
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You can create a new category by selecting the + Category button. That will take you to a new screen where you 
can add a category. You can add an image to the category or a layout. If user selects “Do not show in template” 
when creating a new template category, that category will only be available with Web products not with Invoice, 
estimate and job templates. 

Note  Flex Categories that are associated with Web Product will not get carried forward to HTML 

If user does not select this check box while creating Template category, that category will be available with Web 
products, Invoice, estimate and job templates. 

 

Web Product Templates 

Web Product Templates are created and mapped to Digital Store Front products. When your customer places an 
order for a product the mapped template becomes the job information for that product and the invoice is placed 
in Pending Documents. 

Web products can also be used for Four51 integration, API integration, DSF legacy integration. For these 
integrations Map to DSF option will not be available. 

Product template will not be included in All Type Tab. For product templates there are different columns 
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When eFlow based DSF integration is enabled, then product list will display the product name, SKU, category, 
status, date modified and the DSF Product Name columns  

Note   For other integrations (i.e Four51, API, DSF Legacy) DSF Product Name column won’t be visible). 

On this page you can select the category for the template. The status will show you if a Product has been linked 
to a template or not. From this screen you can select the option map DSF product(s) with PrintSmith product by 
clicking on Map to DSF. From here users also have provision to edit Product detail. To edit Product detail, you 
have to click Product name, this action will redirect you to another screen where you will see other options 
depending on the status of the product. If the product is not linked to a template, then you will see the option to 
either select a template from the library or Set a New Template. If the product already has a template, then those 
buttons will be inactive and you can review the information or use Map to DSF to map PrintSmith product with 
DSF product(s). User can delete or duplicate web products using three dots icon in first column 

 

You can also select the Map to DSF from the first screen. Using either method will take you to another screen 
where you can map the web product to a DSF product. 
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The DSF products will be listed at the bottom of the screen. You can map the specific DSF products by checking 
the box to the left and they will be removed from the bottom of the screen and moved to the top of the screen to 
show you that they have been mapped. 

Note  You can map more than one DSF product(s) to the same PrintSmith web product, but only one job 
can be linked to a web product. 

To link a template to a product you can Select from Library or Set New Product. Select from Library takes to a list 
of existing templates. You can select from Job, Estimate or Invoice templates. If you select Job Templates, you 
will see a list of them. If you select Estimate or Invoice templates, you will need to enter the appropriate estimate 
or invoice number and then select Proceed. 

If you use Set New Product, then you will need to create the template by entering the job information just as you 
would for add new job. For information on creating a new job see page 35. 

 

If the user selects a Product that does not have a Template linked to it, you will be taken to the same new 
screen. The only difference is that if you are creating a new product you will need to enter the name. The SKU 
will be automatically entered. The SKU number consist of fixed prefixes and a number, the number is what 
makes the SKU unique and is incremented with each new SKU. The program will also not allow duplicates SKU.  
With the name and SKU entered you have the choice of adding a template from the library or creating a new 
template to link to the product. 

If you choose using a template from the library the user has the option to select template from Job Template list 
or from Invoices or Estimates. 

1. When job Template is selected the user has the option to add an existing template from Job Template 
List for the Web Product. 

2. When Invoice is selected the user has the option to search invoices with an invoice number and select 
job from the invoice to add an existing template for the web product. 

3. When Estimate is selected the user has the option to search estimates with an estimate number and 
select job from estimate to add as template for web product. 

Note If invoice/estimate contains multiple jobs, user will be able to select only one job for job template. 
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4. To add template to Web Product, select templates or job from the list and click on Add. 
5. If you need to edit the template, you need to select the edit button in the template row and you will be 

taken to the template screen where you can modify the template. 
6. Save the template 
7. Save the product 
8. If you want to delete the template associated with Web Product you could do so by clicking on delete 

button present under Action Column. 

If you choose to create a new template, you will be taken to the template creation page where you enter the job 
information for the template. Once that is done: 

1. Save the template 
2. Save the product. 

If you have set the program up to integrate with DSF then when you look at a product you will have the option to 
map that product to a DSF product.  

Tip          After you associate a template with a Web Product, you can later edit the template (by clicking Edit 
template) or remove it altogether (by clicking Remove template).  

 

    

 

Email Templates 

Use the E-Mail preferences to configure your e-mail account with PrintSmith Vision so that you can e-mail 
various documents, for example, estimates, invoices, purchase orders, statements, and credit memos. As part of 
configuration you can specify what the body of each type of e-mail includes.  
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To set up the email you must go to the Legacy version and then go to Preferences > System > Email. 

 

 
 
 

Customize e-mails  

By default, the recipient, subject, PDF file name, and body in an e-mail message are as follow:  

• Recipients For a document to be mailed, the default recipient must have an e-mail address defined:  
o For estimates and invoices, the default recipient is the invoice contact.  

o For credit memos, the default recipient is the invoice contact.  

o For statements, the default recipient is the account statement contact or invoice contact 
(depending which is being used for the statements).  

o For purchase orders, the default recipient is the supplier specified in the purchase order.  

• Subject  
The subject of the e-mail is Company Name: Document Type #xxx, for example, Vermont 
SuperPrints: Estimate #323. The company name is taken from the first line (Company) of the 
Address in your Company preferences.  
If, however, you select the Use log text as subject and file name check box in these E-Mail 
preferences, the log text you specify is used for the subject line instead.  

• PDF file name  
The name of the PDF attachment is Document Type #xxx.pdf, for example, Estimate #234.pdf or 
Statement #432.pdf.  
If, however, you select the Use log text as subject and file name check box in these E-Mail 
preferences, the log text you specify is used for the file name instead.  
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• Body  
The body of the e-mail is defined in these E-Mail preferences (see step 3 below). 

To customize e-mails  

1. To allow users to customize certain types of e-mail messages before they are sent, select the Customize e-
mail fields before sending check box.  
When the Customize e-mail fields before sending check box is selected, each time users click the E-Mail 
button in the Invoice or Estimate window or in the Purchase Order window, they can add recipients, change 
the subject of the e-mail, and edit the body.  
Important  The Customize e-mail fields before sending check box does not apply when you e-mail 
invoices from the Cash Register or Post Payments window, e-mail credit memos from the Journal Entry 
window, or e-mail statements (AR > Generate Statements). In these situations the e-mails are sent without 
any input from users – the e-mails cannot be changed.  

       2.  To send a copy of the e-mail to the sender, select the Include sender on CC line check box.  
       3.  For the E-Mail Body, click each tab (Invoice, Estimate, Credit Memo, Statement, and Purchase Order) 

and enter the message you want the e-mail to include.  
Note  The body specified on the Invoice tab applies to e-mails sent from the Invoice window, the Cash 
Register window (for posted invoices), and the Post Payments window (for paid and posted invoices).  

The body of the e-mail can include:  

• Text  
Text can be anything you want. For example, depending on the e-mail being sent, you may want to include 
text such as Your invoice is attached or We hope to do business with you again.  

o Enter the text and use the formatting toolbar to change the font, point size, style, color, and 
justification of text.  

 
Note You can only select a font from the list; you cannot add your own fonts to the system.  
Currently extra spaces between characters are not preserved when you send e-mails.  

 

• Place holders  
Place holders are replaced with actual data when the e-mail is sent. For example, [DocumentNumber] 
is replaced with the number of an invoice or estimate; [AccountName] is replaced with the name of the 
account; [Supplier] is replaced with the name of the supplier for purchase orders; and so on. The 
available choices depend on the type of e-mail you are sending.  
[FirstName], [LastName], [JobTitle], [UserName], and [EmailAddress] always come from the user 
definition of the logged-in user so are helpful if you want to identify the user who sent the e-mail in the 
e-mail itself.  

o To enter a place holder, select it in the Place Holder field and click Insert.  
 

Note  Place holders are always added at the end of the e-mail body, not where the pointer is. Once a 
place holder is added, cut it and paste it where you want it.  

 
You may want to include text next to some place holders to explain what the data represents, for example, 
precede [DocumentNumber] with Estimate Number or [DocumentTotal] with a currency symbol. 


• Images  
You can include an image such as your logo in the e-mail. To do so, click Add Image and locate and select 
the graphic you want to use. The name of the image (not the image itself) is displayed.  
Notes  Make sure the image is the correct size before you add it; you cannot resize images in PrintSmith 
Vision. The image is always added at the end of the e-mail body, not where the pointer is. Once it is added, 
cut the image (meaning IMAGE SOURCE=‘image name’) and paste it where you want it.  

  

• Hyperlinks  
To include a hyperlink in the e-mail body:  

o Enter the text for the link. For example, this could be a URL such as http://w3.efi.com/ or text such 
as Click here for more information or Visit the EFI web site. You can also hyperlink an image 
such as the Facebook or LinkedIn icon.  

o Select (highlight) the text of the link or name of the image (meaning IMAGE SOURCE=‘image 
name’). 

o Enter the URL in the http:// field. (The http:// field is unavailable until the hyperlink text is selected.)  
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The link (text or image) can now be clicked to take you to the specified site.  

4. To see what the e-mail will look like (together with any images you added), click Preview and then close 
the preview window. (Place holders will be replaced with real data when the e-mail is sent.) 

 

Table Editor > Vendor 

Beginning with version 4.1.0 the vendor and supplier table are merged and displayed as one table in HTML, 
labeled Vendor. Going forward the supplier table will be listed as Vendor table in purchase order in HTML. A user 
using HTML will not be able to edit/delete the vendor details and supplier details in Flex.  
 

Table Editor will take you to a short cut menu where you can enter or edit vendor information. Selecting the plus 
+ will allow you to add a vendor or you can select an existing vendor from the drop down. 

NOTE  You can only add vendors from this screen. The user must have access to suppliers to edit or add 
vendors. 

 

 

Opening other portions of the screen will allow you to enter contact detail or miscellaneous information. You can 
enter up to 4 contacts on the contact screen. On the Miscellaneous screen you can enter information about the 
vendor such as the material they supply, tax ID, payment terms, etc. You can also identify when you need to 
send the vendor a tax exemption notice 

Note You must check the box “Use in Purchase Order” in order for this vendor to be displayed on the 
vendor list in the purchase order program 

 

Preferences > CardConnect® Setup and Credit Card manager 

This is used only if you are using CardConnect® to process you credit card transactions. For information on 
setting up and managing CardConnect® see the CardConnect® Integration document. 
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Logging in to PrintSmith Vision 

When you log into PrintSmith Vision you will be given the option of using the Legacy version or HTML5 version 
which is referred to as Fast-track. For some functions you can still use the Legacy version. When you log in to 
PrintSmith you will first see this screen. 

 

Selecting the option to “Login to Legacy” will take you to the Legacy version. If you select “Continue to the Fast-
track version you will be taken to this sign in screen. You can use the “Don’t show this on every login check box if 
you only use one version. 

NOTE You can still move from Fast-track to Legacy from each program. 

 

After signing in you will be taken to the Quick Access Panel screen 
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Quick Access Panel 
 

Quick Access panel not only provides shortcuts to your most commonly used features, it provides a view of the 
status of orders taken by the logged in user or for the entire plant. Quick Access includes:  

• Estimate and invoice totals for the previous day and current day.  

• Year to date and month to date totals of orders, sales, and journal entries.  

• Lists of invoices due today, overdue, and optional custom field. To change the custom field you must go 
to the Legacy version Preferences > System > Dashboard. This allows you set the location to be used 
to filter jobs. 

• A list of estimates still in a pending state, with the ability to open and review them. When an estimate is 
open, you can convert it to an invoice so you can go ahead and produce the job and bill the customer.  

• A log of the communication that has taken place with customers, with the ability to follow up on issues.  

• Quick access to other applications. 

NOTE The user has the option of displaying their user information or the information for the entire ship. 
This is controlled by the Show Only My Records slide bar. If it is on, then the widgets will only display the users 
information and if it is off then the display will be of the entire shop. The headings for the widgets will indicate if 
you are seeing the shops information or the users. 

   
            

 

 

“Show only my records” changes the display for Due Today, Ordered, On Proof, Pending Estimates and 
Customer Log to display only items for the logged in user. 

Quick Access 
Buttons for 

Other 
Applications 

Search  
Options 
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“Customize Mode” allows you to remove Quick Access buttons or displays. Remove items by selecting the red X 
that is displayed when in the customize mode. 

“Add/Remove Options” allows you to change the display to only show the items you want to see by checking or 
unchecking the appropriate boxes. 

 

“Restore Default” changes the display back to the original default status. 

In addition to the Customize Mode and the Add Remove Options you can remove individual panes by selecting 
the Remove Widget feature 

 

Note If you have made changes to Quick Access those changes will still be in effect after the update. If a 
user does not have permission for a feature the feature will still be displayed but will be grayed out. 

Getting Ready to Use the Quick Access Panel 

A few steps are necessary to get Quick Access ready for use:  

1. Set your Quick Access Panel preferences.  
2. Decide which access groups should have permission to view the Quick Access.  
3. Understand the Taken by field.  

Set your Quick Access Panel preferences  

Note  The setup is done in the Legacy version 

1. Click Preferences in the Quick Access panel (or select Admin > Preferences).  
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2. Under System, click Dashboard 
3. Set the preferences as described below and click Save 

Dashboard preferences  

Use the Dashboard preferences to control some aspects of the Dashboard. 

  

1. To remind users after they log in that they have some number of items to follow up, select the Show 
follow-up count at user login check box.  
When this check box is selected, if a user has follow-up items that are either due today or past due, a 
message is displayed after the user logs in and gives the user the option to open the Dashboard right 
away 

2. By default, the sales and journal entry numbers in the Dashboard include tax. To omit tax from the 
totals, select the Exclude tax from Sales and Journal Entries check box. 

3. The On Proof pane in the Dashboard lists all the invoices with jobs currently going through proofing. For 
invoices to be listed in the On Proof pane, in the Pick ‘Proof’ production location field, select the location 
that corresponds to proofing in your organization, for example, Proof. (These locations are defined in 
the Production Locations table, which you can edit with Table Editor.) The name of your proofing 
location is then used in the title of the On Proof pane, for example, if the location is Proofing, the pane 
will be named On Proofing.  

4. When the location of a job is set to the proofing location defined in the Dashboard preferences, the 
invoice will be listed in the On Proof pane 

Give access to the Quick Access Panel 

You can control access to the Quick Access through security settings. Any user who is part of an access group 
with Help > My Dashboard selected in the Security Setup window (Admin > Security Setup) can open and view 
Quick Access. Quick Access is identified as Dashboard in the security setup. 

To prevent the users in a particular access group from seeing all the customer log information in the shop, make 
sure the Help > Quick Access Show All Customer Logs permission in the Security Setup window is not selected. 
As a result, the All button is unavailable on the Customer Log tab.  

Also, if you want to prevent the users in a particular access group from seeing YTD and MTD total order, sales, 
and journal entry numbers, do not select the Help > Dashboard Show Sales Values setting in the Security Setup 
window. As a result, dashes instead of numbers are displayed.  

Note Users who do not have permission to review a document (Invoice > Review Any Document) or open a 
document from the pending list will also be prevented from opening a document from the Quick Access.  

Understand the Taken by field  

When you create an estimate or invoice, the Taken by field in the Account Info window (see page 61) is 
automatically set to your user (login) name, but this field can be edited.  

Note  The Taken by field is case insensitive (Dhina and dhina are the same).  

When you open Quick Access, the orders that you see are those that you took – they have your user name in the 
Taken by field. You can, however, see orders taken by all other users (but not specific users) by clicking All in 
some of the panes of Quick Access.  

Web orders, for example, orders coming from PrintSmith Site, Digital StoreFront, and Four51 are not taken by a 
particular user, however. In this case, the information in the Taken by field in the Account Info window comes 

Defined in 
Production 
Locations 
Table 
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from the Taken by field on the Site tab of the Web Administration window (Admin > Web Administration) and is 
used for all incoming Web orders.  

If you are integrated with PrintSmith Site, Digital StoreFront, or Four51, EFI recommends that you set the Taken 
by field on the Site tab of the Web Administration window to the user (perhaps admin) who is most likely to want 
to track these Web orders in the Quick Access. Whoever opens the Web orders, however, can still edit the 
Taken by field in the Account Info window and enter a different user name there. 

About the Quick Access Panel Contents  

Some information in the Quick Access applies to the logged in user (whose name is in the Taken by field in the 
Account Info window as described above). In the descriptions of the Quick Access that follow, “you” refers to the 
currently logged in user. Other information in the Quick Access applies to the entire shop. You can view your 
own information (for example, see orders that you have taken) or view information for the entire shop, but you 
cannot view information for another user. Likewise, another user cannot see your information.  

Note  As described in “Give access to the Quick Access” above, you need permission to view all 
customer logs. 

Tip   Quick Access Panel is updated automatically every 5 minutes.   

The sections that follow describe the different parts and features of the Quick Access Panel.  

Total Widget 

 

The Total Widget summarizes the estimates and invoices that were created on the previous and current day, as 
well as year-to-date and month-to-date totals for orders, sales, and journal entries. It shows those that came from 
the shop and those that came in over the web. 

Notes Unless you selected the Exclude tax from Sales and Journal Entries check box in the Quick Access 
preferences the Sales and Journal Entries numbers include tax.  

The totals exclude any voided estimates or invoices.  

Estimates 

• The Estimates section shows the total dollar amount of the estimates that were created on the previous 
day.    The number of estimates is shown in parentheses.  

• The Invoices column shows the total dollar amount of the invoices that were created on the previous 
day. The number of invoices is shown in parentheses.  

Invoices  

• The Invoices section shows the total dollar amount of the estimates that were created so far on the 
current day. The number of estimates is shown in parentheses.  

• The Invoices column shows the total dollar amount of the invoices that were created so far on the 
current day. The number of invoices is shown in parentheses.  

Total Orders  

The Total Orders columns provide information about invoices that were created for orders. Total Orders include 
invoices that are still on the pending list, as well as invoices that were picked up. Total Orders do not include 
voided invoices.  

If you do not have permission to see company sales numbers dashes are displayed instead of numbers under 
Total Orders.  
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Sales  

The Sales columns provide information about all the invoices that were picked up (meaning invoices that were 
charged or paid for by cash, check, or credit card).  

Note Unless the Exclude tax from Sales and Journal Entries check box is selected in the Quick Access 
preferences the Sales numbers include tax.  

• The “This Year” column shows the total dollar amount of invoices picked up so far during the current 
year. (The current year is based on the fiscal year set in your Business Calendar preferences and the 
range is displayed in the bottom left corner of the Quick Access.)  

• The “This Month” column (for example, MTD Mar-16) shows the total dollar amount of invoices picked 
up so far during the current month.  

Journal Entries  

The Journal Entries columns provide information about journal entries that were recorded and posted. These 
numbers may be negative. Voided journal entries are not included.  

Note  Unless the Exclude tax from Sales and Journal Entries check box is selected in the Quick Access 
preferences the Journal Entries numbers include tax.  

• The “This Year” column shows the total dollar amount of journal entries posted so far during the current 
year. (The current year is based on the fiscal year set in your Business Calendar preferences and the 
range is displayed in the bottom left corner of the Quick Access.)  

• The “This Month” column (for example, MTD Mar-16) shows the total dollar amount of journal entries 
posted so far during the current month by the shop as a whole and by you.  

If you do not have permission to see company sales numbers, dashes are displayed instead of numbers under 
Journal Entries.  

Note  The sum of the Sales and Journal Entries numbers represents actual sales for the period. 

Note  The displayed information for each widget depend on if you have selected to “Show only my 
Records” or not. 

Due Today Widget 

 

• To help you track what needs to be done today, the Due Today widget lists invoices that are due today. 
The total number of the invoices due today is shown at the top of the pane.  

• If the list is long, click Show All to open a window that shows all your invoices that are due today. This 
will open Pending Documents in a new windows and display invoices. 
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• To open an invoice and review its details, double-click it. 

 

Overdue Widget 

The Overdue widget lists all your invoices that have a due date in the past. The total number of these late 
invoices is shown at the top of the pane.  

Note  If an invoice is due today at 12:00 PM, it will be considered overdue any time after 12:00 PM, but it 
will still be listed in the Due Today pane.  

• If the list is long, click Show All and the pending documents window will display in a new window all 
overdue invoices.  

 

• To open an invoice and review its details, double-click it.  

On Proof Widget 

 

The On Proof widget lists all your invoices that have jobs out for proof. The total number of these invoices is 
shown at the top of the pane. The Item# column identifies the job in the invoice that is out for proof.  

Note  For invoices to be listed in the On Proof pane, the location of a job in an invoice must be set to the 
proof location specified in your Dashboard preferences. 
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The title of this pane will match the name of the location you selected in your Dashboard preferences, for 
example, if the location is Proofing, the title of the pane will be On Proofing. 

The Show all option will open the Work In Progress page in a new window. 

Pending Estimates Widget 

The Pending Estimates tab at the bottom of Quick Access lists all your active estimates – these are quotes that 
either were not yet accepted by customers or were accepted but have not been converted to invoices yet. The 
value of those estimates is displayed at the top of the tab.  

If a customer accepts an estimate and gives you the go-ahead to proceed with the job, you can open the 
estimate from the Dashboard and convert it to an invoice. An invoice includes the agreed-upon price and details 
of the work to be performed and then serves as a bill for this work. 

 

 
If the list is long, click Show All to open a Pending Documents window that shows all your pending estimates.  

From the Pending Documents window you can open and edit an estimate.  

• To open an estimate and review or edit its details, double-click it or click Open.  

• To convert an estimate to an invoice when the customer has accepted your quote:  
1. Double-click the estimate or click Open.  
2. Make any necessary changes to the estimate. For example, if the estimate includes multiple 

quantities, select the one the customer wants.  
3. Select Invoice > Convert to Invoice.  
4. When asked about recalculating the document, click Yes to ensure the invoice has the latest 

pricing information.  
5. When the Account Info window opens, make any necessary changes and click OK.  
6. Click Save to save the invoice. 

Customer Log Widget 

The Customer Log widget at the bottom of Quick Access lists all customer issues that you logged with a follow-
up date of today or in the past.  

Tip   You can log entries and enter follow-up reminders in the Notify Customer window. This window can 
be opened by clicking a Notify button in the following windows in PrintSmith Vision: Pending Documents, 
Contacts, Customer History, Work in Progress, Post Payments, and Journal Entry.  

 



Quick Access Panel |  33 
 

 

 

 Estimating 

Creating Estimates 

Several of the options and steps to create an estimate are the same for creating an invoice. 

From the estimating application you can create new estimates or update an existing estimate. 

When you first open the estimating application you will see the screen where you identify the customer, contact 
and how you want to create the estimate. You can create a new estimate from a new job, account history, job 
templates or templates. 

1. Select the customer. You can just start typing or use the dropdown to select your customer. The default 
will display both accounts and contacts, so you can select either. You can also determine if you want to 
display prospect or not. 

You can search for the account by account number, phone number or email address using the search code 

prefixes listed below. 

   

 

When searching with Account + Contact  selected and Prospects unselected you will only see accounts.  

With Account + Contact unseleced and Prospects selected you will only search Prospects. 

With both selcted you will search for both Accounts and Prospects. 

 

Prospects have not yet done business with you, but you hope to turn them into customers. Customers have done 
business with you, and invoices have been created for them. Once you create an invoice for a prospect, that 
prospect is automatically converted to a customer. If customers become inactive, they can be turned into 
prospects again.  

 

You can identfiy the type of account by the symbol next to the name.
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Why use customer accounts?  

EFI strongly recommends that you associate a customer account with most of the documents that you create. 
Not only does a customer account include key information such as name, address, and phone number, but it is 
also used to determine if an invoice exceeds the customer’s credit limit. In addition, the account determines 
whether a deposit is needed, what type of payment is acceptable, whether a PO is required, or if an automatic 
discount should be applied to the order. The tax table (which may change the tax rate), tax code, and tax status 
are also based on the assigned account. The customer account can even affect special instructions on job 
tickets and documents. 

When customers use your services, you want them to continue using your services. If you set up an account for 
them, you can examine their history, mark them as inactive, generate mailing labels, and market to them. The 
history that PrintSmith Vision maintains also helps you identify customers who only use you as a source for 
quotes and never send you any orders. You can find out why you never get their orders and decide whether you 
want to continue giving them estimates. 

For all these reasons, the walk-in account should be used just for customers you never expect to see again. If 
you start using the walk-in account for repeat business, you will have history for the walk-in account, not for 
individual customers.  

In addition, you could end up with history for the same customer in both the walk-in account and a customer 
account. Imagine that you select the walk-in account when creating an invoice for Bob’s Hardware and enter the 
customer name and address directly into the invoice. Later, you create a customer account named Bob’s 
Hardware and create more invoices. Now you have several invoices for Bob’s Hardware, but one is for the walk-
in account and the rest are for the Bob’s Hardware account. If you try to pick up all the invoices at once, 
PrintSmith Vision does not let you since invoices being picked up together must all belong to the same account. 
Worse, if you pick up just the walk-in invoice, it will not show up in Bob Hardware’s history — it is in the history 
for the walk-in account.  

Tip   To reduce this type of problem, EFI recommends that after you create a document for a new 
customer using the walk-in account, you use Invoice > Create Customer Document to create an account for 
that customer. Doing so also greatly reduces the number of documents assigned to the walk-in account. If an 
account already exists, and the document was created using the walk-in account, click Account Info on the 
toolbar of the document window (or select Invoice > Change Account) to select the correct account. 

For one-time business, you can select the walk-in account (displayed as <<< WALK IN >>>). If necessary, you 
can always use the information you entered for a walk-in customer to create a new customer account. 

Note  EFI strongly recommends that you use the walk-in account only for one-time business. If you 
select the walk-in account for many different customers, you will find it very difficult to track history effectively. 

  

 

2. Select the contact. When you select the account, the program will automatically enter the default 
contact person, but you can change the contact by using the dropdown. 

  

 

 

3. Select the process you want to use to create the estimate. 

There are different options for creating a new estimate depending on your preference settings. Under 

Preference > HTML you have the option of selecting Template Category View. With this unchecked you will 
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see the options of creating an estimate from a new job, account history, job templates or invoice/estimating 

templates. With this checked the options will change to a new job, account history or template. When you 

select template, you will be shown a list of template categories that you can use to find a template. For more 

information on “Creating Template Categories” see page 17. 

4. Select Continue. This will take you to the Job Details screen where you will enter the information about 

the job. Often you do not need to make any changes to the account information but if you do you can 

move to that tab. Account information options will be discussed later in this document 

Create New Job (Job Methods) 

After selecting New Job, you will see several options as to Job Method. Once you have selected the job method 
you will see a job detail sheet specific to the job method you selected. Job Methods are defined under 
Preferences > Estimator > Pricing Method.  

Note  The pricing methods that are available as selections and their names are controlled by preferences 
(Admin > Preferences > Estimator > Pricing Method). You may want to change the name of the pricing 
method so that it makes sense to your company. For example, you may want to change Printing to Offset, 
Outside Services to Outsourced or Buyouts, or Color to Digital Color. What you see in your job method 
therefore may not match some of the examples in this manual. In addition, if you activated and customized any 
of the “Merch” pricing methods, they will also be available as job method selections.  

Each pricing method is designed to handle a particular kind of job: This document will list some of the different 
job methods and how they are set up. 

 

• Printing for an offset job on a standard sheet-fed press. See page 35.  

• Roll Fed for a job on an offset web press. See page 48.  

• B&W for a black-and-white job on a copier or digital press. See page 49. 

• Color for a color job on a copier or digital press. See page 49. 

• Large Format for a wide-format digital job. See page 51.  

• Charges Only for an order that includes just setup or finishing charges (no printing). See page 51.  

• Blank for pricing a job for blank stock. See page 52.  

• List for a job based on a price list. See page 53.  

• Outside Services for a job that is sent to another vendor. See page 56.  

• Merchandise for any other kind of job that is not accounted for by one of the other pricing methods. 
See page 57.  

• Multi-Part Job for a job that includes sub-jobs. See page 57.  

• Free Style. See page 59. 
 

Printing Job 

The Printing job method is for offset jobs that are printed on a sheet-fed press. These jobs are based on sheet-
fed press definitions.  

1. Follow the general procedure for creating a job and select Printing as the job method. (Your company 
may use a different name for this job method.) 

2. The job method will default as printing but can be changed. 
3. Select the product. In the Product field, select the type of product the job represents. (You can use 

Table Editor to define product types in the Products table.)  

Note  If Product Type for Job is selected in the Mandatory Field preferences, the Product field is 
outline in red. You must select a Product before you can save the job.  

4. If necessary, change the settings of the Brokered or Finished check boxes. (Brokered is automatically 

selected if you create a job based on the outside service pricing method.) Identify if the job is Finished 

5. If you are using Tracker, in the Location field, select the area where the job takes place. 
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6. Select the Press. This is the press configuration that will be used to determine the price of the job. 
Select the correct press definition for the job. (Your choice affects the price of the job.) The press 
specifications will be compared to the stock selected and you will receive a warning if the stock size 
does not match the press. 

7. Enter a description 
8. If this product uses a stock then you can use the drop down you can select the stock to be used. When 

you select the stock the parent size will automatically be filled in from the stock information.  
9. Complete the run size, finish size, folded size, original sheets and UP/ON. With this information an 

image of the layout will be displayed. 
Note The Up and On fields are calculated automatically based on the settings in the Paper Calculator 
window, but change them as necessary. Up indicates how many images fit on the run sheet. On indicates 
how many unique images (originals) you have. Again, if you are producing one kind of flyer this should be 
set to 1. 

 

10.  In the Sheets field, enter the number of originals involved. Sheets can also be the number of versions 
if, for example, you are producing four different variations of a flyer. If, however, you are producing one 
kind of flyer from one original, you should leave Sheets set to 1.  

11. The Press field shows the number of impressions needed to get a finished quantity and is calculated by 
dividing the number Ordered by the number Up. (If the Press total cannot be divided evenly by the Up 
number, it is rounded up.) Change the number in the Press field if necessary, but keep in mind that 
PrintSmith Vision will then change the number in the Ordered field.  

12. Enter the run method. Often only one option will be available based on the press and stock. 
13. Enter ink information and run method. You can identify the number of colors, passes and washes for the 

front and back of the material. You can also select or type in the ink to be used from the dropdown. 

a. For Colors, specify the number of colors to be printed on the front and back. The default is 1, but 
for multi-color jobs, enter the number of colors.  

b.  For Passes, specify the number of runs that are needed for the number of colors specified. Initially, 
Passes is based on the number of color heads in the selected press. If you need to run one color 
twice, you can change the number of passes as long as it is higher than the minimum number of 
passes. (This is considered an override.)  

Note  Labor and run time are based on the number of passes, not the number of colors. Charges are 
based on the number of colors, not the number of passes. 

c. For Washes, enter the number of press washes for each side of the job. The number of washes 
(on both sides) is multiplied by the wash rate in the press definition and added to the price of the 
job.  

d.  Click the Ink field and select (or enter) up to six colors. (The available selections come from the Ink 
Color table, which you maintain with Table Editor.)  

Notes  For CMYK, enter each color in a separate field (four fields altogether). When you select an ink  
here, it is not billed. To include the ink in the job price, you must add ink charges. 
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You can type in a PMS ink in the small box displayed in the line. That ink will be displayed in the short cut menu 
and selecting the plus sign will enter that ink in the line. 

 

14. Enter the quantity. By selecting the + next to the quantity field you can enter multiple quantities. All of 
the information already entered will be copied over to the additional quantities. You can enter the new 
quantity in the new quantity field for the additional quantities. You will also see additional fields at the 
top of the screen with each of the quantities so you can tab between quantities. Select the confirm 
button after entering a new quantity and it will be reflected in the quantity options fields. 

 

 

15. The In Sets of field typically applies when carbonless or NCR stock is being used for the job, and 
indicates the number of sheets in a set, for example, for 3-part NCR, enter 3 in the In Sets of field. 
Otherwise, this field is not used.  

Tip  For an item like pads, enter the total number of items in the Ordered field. For example, if you need 
100 pads of 25 pages, you would enter 2500 in the Ordered field and 1 in the Sheets field. You would then 
use charge definitions to make the pads themselves.  

16. Finishing operations (such as bindery) may have some associated waste. As you add charges to the 
job, any associated waste is calculated and added to the Bindery Waste field. If necessary, enter a 
different number in the Bindery Waste field, but avoid doing this until you have added all finishing 
charges to the job.  

Note  When a finishing charge is defined in sets, the waste is the number of sets (not sheets) that are 
spoiled.  
 
17. You can add Charges to the job using the “Add New” button available in the Job Details Screen.  

Note  When you are adding charges or modifying any existing charges, make sure to click on Confirm 

button and Done button to save the charges to the Job.  
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Special Order 

  

If the stock requires a special order, click Special Order and complete the Stock Definitions window with 
information about the stock. 

If the stock for the job is not part of your inventory, then you can select the option for Special Order. This allows 
you to specify a special-order material. Here you can enter all the material specifications. 

If user wants to add the special-order stock into Stock definition for re-use, then you need to enable “Use in 
future” option.   

 

 

After completing the first screen, the second screen allows you to enter cost information for different quantities. 



   Estimating |   39 

 

 

 

 

 

Select Done when you are complete, and the information will be copied to the job detail screen. 

 

Stock Picker 

 If you want to see the full list of stock you can use the stock picker. 

 

 

You can look at all of the stocks in inventory from the stock picker list. You can use the blank fields at the top of 
the screen as filters. For example if you only want to see 80# stock enter 80 in the field below weight. When you 
select a column heading you will see an icon that allows you to sort according to that column in order or reverse 
order. Highlight the stock you want and select the confirm button. The stock information will be entered 
automatically in the job detial screen. 
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Paper Calculator 

 

You may not need the paper calculator in all cases. The Paper Calculator will help in determining the amount of 

parent sheets needed and the material cost. You enter the specifications and the system will calculate the 

amount of material needed for the job. 

Review the settings in the Paper Calculator window, change them as necessary, and click Save.  Be sure you 

specify the correct Run Size and Finish Size as an example. 

 

  

 

Using the Paper Calculator  

Although not an imposition tool, Paper Calculator lets you specify certain aspects of the layout such as bleeds, 
gutters, and white space. Paper Calculator also shows you the number of sheets out and the number of cuts for 
any combination of parent, run, and finished sheet sizes. Although you can provide this information for each job, 
you can create paper templates for your standard layouts and re-use them in future jobs.  

Changing settings in the Paper Calculator window  

• When you open the Paper Calculator window opens after you select a stock for a job, the window 
already includes some information about the dimensions of the stock. Otherwise, you must provide this 
information. Always check the run and finish sizes and make sure other layout settings are as you want 
them.  

Note  The default settings of certain fields in the Paper Calculator window are controlled by your paper 
calculator preferences, but you can change them when using the Paper Calculator for a particular job.  

• The settings and features in the Paper Calculator window include the following:  
o If you have created paper templates, click Find on the toolbar to locate and select a template 

for the job. The Template Name field then shows the template you selected. 
o Parent Size: The size you purchased.  
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o Run Size: The size of the paper that goes through the machine. Change this by selecting a 
different size or entering a size.  

o Finish Size: The final size of the paper after the job is done. Change this by selecting a 
different size or entering a size.  

Selecting the slide bar will display the options for the following elements. 

• Grip Edge / Gap: Select this check box to include a gripper edge. This is the amount of space required 
on one feed edge of the run sheet for the press to pick up the paper. You may be able to ignore this 
setting due to the placement of the image on the page. The size of the grip edge usually comes from 
the press definition but may come from your Paper Calculator preferences. You can, however, change 
the grip edge/gap in the Paper Calculator window for an individual job.  

• Folio Edge: Select this check box to include a folio edge. This is the amount of space that is reserved 
on an edge of the run sheet for a multi-part job. The folio edge is used when folding signatures to offset 
the imposed image and to leave one edge of the folded signature overhanging the other. If both the 
gripper and folio use the same edge, the larger of the two is used (they are not added together), and the 
edge is displayed half in red and half in green.  

• Color Bar: Select this check box to include a color bar opposite the gripper edge.  

• White Space: Select this check box if you want to define a part of the run sheet as unusable and have 
control over the page layout.  

• Gutter: Select this check box to include a space between multiple images on a sheet. The first value is 
the vertical gutter; the second is the horizontal gutter.  

• Bleed: Select this check box to include bleeds. A bleed extends the printed image beyond the edge of a 
page. This overlap is then trimmed to produce the final printed piece. Bleeds generally increase the 
number of cuts because the bleed must be trimmed off each finish sheet in addition to any cuts needed 
to separate each sheet.  
You can specify a different bleed for each edge, but since generally the same bleed is used for all sides, 
you can just enter a value in the Top field. The other bleeds are then automatically set to the same 
value. Bleeds are shown as blue borders around each sheet and are added to any gutter that is 
specified.  

Select the appropriate check box for these items as needed. 

• Work and Tumble: Select this check box to change the cut-out diagram for tumbling by showing two 
gripper edges. (The Work & Turn label in the Job window then changes to Work & Tumble.) Except 
for a possible change in the number of sheets out due to the additional gripper edge, no other change to 
pricing is made as a result of selecting the Work and Tumble check box.  

• Back Trim, Parent: Select this check box if you consistently trim the edges from all four sides of the 
parent sheet. This effectively adds four cuts to the parent cut and centers the run sheets in the parent 
sheet.  

• Trim Four Sides: Select this check box to center the image by trimming the edges from all four sides of 
the run sheet. This typically results in the best ink coverage.  

• Disable FSC options: Select this check box if a stock is tracked for chain of custody (such as FSC 
certification), but the customer did not request a certified stock, and therefore you want to omit the chain 
of custody information from the document.  

• Run to Finish Grain: If necessary, change this from Neither (where a best fit strategy is used without 
any sheet rotation) to Match Grain (sheets are never rotated to improve the number of sheets out) or 
Swing/Combination (sheets may be rotated to maximize the number of sheets that can be cut out).  

Notes  Sizes are defined in the Dimension table which you can edit with Table Editor.  

The area on the right shows the cut diagram. Select Parent & Finish; Parent & Run; or Run & Finish to change 
what is shown. 

Tip  When you are finished be sure to select Confirm 

Note The confirm button does not save the estimate. To save the estiamate you must select the SAVE 
button on the estimate summary screen. 



42  EFI Productivity Suite | PrintSmith Vision User Guide 

 

 

 

Supplied Stock and Special Order 

If the stock will be supplied check that box and the cost of the stock will be removed from the price of the job. 

If the stock requires a special order, click Special Order and complete the Stock Definitions window with 
information about the stock. 

 

 

 

Job Notes 

Selecting Job Notes will take you to a screen where you can add job ticket notes. “Add Time Stamp” will put the 

date and time with the notes. 

 

. 

 

 

Digital Assets 

The Digital Assets option will allow you to upload digital files. 

Delete button 

       User can delete individual job from the job details screen using Delete button 

Note:  When a user deletes the job and confirms they are taken to Estimate/Invoice summary screeb. 

Confirm 

Once the information has been entered selecting Confirm will save the job information and you can move to the 

estimate summary screen. 

Important Selecting Confirm does not save the estimate. You must use the save button on the estimate 

summary screen. 
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There are several command options available when you create a job. 

 

 

  

Carton Labels: 

You can create labels for the containers that hold the finished job. You can also define the format of these labels. 

Note You must save the estimate from the estimate summary screen before you can print labels. 

 

 
1. If necessary, in the Label Format field, select a different format. Carton Labels is automatically 

selected as the Label Format. You can create and edit label formats by clicking Define Label Format.  
2. Enter a Total quantity 
3. Enter Items Per Box 
4. Enter Number of Boxes 
5. Enter a Starting Number, if is other than 1, as well as a Ending number 
6. If you have a partial sheet of labels and you need to skip over them to the first good label, enter the 

number in the Labels to skip field.  
7. In the Label Text field, enter any additional information to print on the label. 
8. Select to use Today’ Date or End Date  
9. Select the information that you want to include on the label, for example, Job Description, Today’s 

Date, or Estimated Weight.  
10. Enter the information on how you want the labels to print 
11. Click PRINT after you specify all the carton label information. 

Defining, editing, or deleting label formats  

You can define, edit, or delete the formats for carton labels. PrintSmith comes with several pre-defined formats 
for labels. You can modify these formats or create as many additional formats as you need using the Define 
Label Format button (see step 2 below).  

The table below describes the pre-defined label formats supplied by EFI. 
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    To define a label format  

1. In the Job window, click Carton Labels on the toolbar or click Carton Labels under Commands. The 
Carton Labels window opens.  

2. Click Define Label Format. The Define Label Format window opens.  

Note  This window is also used for defining, editing, and deleting shipping and mailing labels. 

3.     In the Existing Formats field, select <new format>.   

4.     Enter a Format Name.  

5.     Specify the label details and click Print Sample to see if the label looks the way you want it.  

6.     Click OK. 

To edit or delete an existing format 

1.     In the Carton Labels window, click Define Label Format. The Define Label Format window opens.  

2.     In the Existing Formats field, select the label format you want to edit or delete.  

3.     If you are editing the format, make your changes; if you want to delete the format, click Delete and then 
click Yes to confirm the deletion.  

4.     Click OK. 

 
Reviewing production data  

 
You can review production data from the Job Window. Here you can review production and pricing information 
for the job. The information displayed in this window comes from your pricing definitions and should not be 
changed except under special circumstances. The information that is displayed also depends on the job pricing 
method. For example, outside service or merchandise jobs have far less data than printing or large format jobs. 

Note  You can prevent an individual user from opening the Production Data window with a security 
setting (select Admin > Security Setup and disable Job Production Data).  
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Review the information in the window:  

Parent Size - The size of the purchased sheet. This is taken from the selected stock. (For large format jobs, this 
is Roll Width, not Parent Size.)  

Parent Costs - Your price for the Parent Size sheet for the number of sheets shown in the per field. (For large 
format jobs, this is for square area.)  

Press/Run Size - The dimensions of the sheet being run.  

Out - The number of Press/Run Size sheets that you can get out of a given parent sheet. (You can override this 
number, but if you do, PrintSmith Vision cannot generate a cutout diagram.)  

Press Speed – This is expresses in Impressions/minute. (For B&W, color, and large format jobs this is Copier 
Speed.) 

Production Run - The number of impressions per run. (This cannot be changed) 

Markup - The markup on the stock (your gross profit on the stock).  

Requires - The number of parent sheets (or other unit) required to run the order. (This cannot be changed) 

Sheets Purchased - The number of sheets purchased for the job. (If the selected stock has a minimum quantity, 
this number may be higher than the actual sheets required for the job. The cost of the additional paper is 
included in the job if the Charge Customer for Entire Order check box is selected in the stock definition.) (This 
cannot be changed) 

Press - The press definition selected for the job. (For B&W, color, and large format jobs, this is Copier – the 
digital definition used for the job.) (This cannot be changed) 

Labor Rate/Markup - The labor rate and labor markup used for the press.  

Setup, Run, Washup, Total Time - The time to set up the press and the time required for washup apply only to 
jobs based on press definitions. The run time is based on information in a press or digital definition.  

 

Job Price  

This area of the Production Data window breaks down the job price: 
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Stock  The Cost, Markup, and Price breakdowns for 
the stock for the job.  

Labor  The Cost, Markup, and Price breakdowns for 
the labor for the job.  

       Itemized Markup The total markup charges (if any) attached to 
the job. Markups are calculated separately 
after all other charges are calculated so they 
are based on the most current prices and 
exclude invoice level charges or customer 
discounts.  
 

        Other Markup The total of all charges attached to the job that 
are not markups.  
 

        Production  The total charged for washups. (For jobs not 
based on press definitions, you can use the 
field to add any additional production fees for 
which you do not already have a charge, for 
example, a delivery fee to an outside vendor.)  
 

        Target Adjust  For offset jobs where you have a price list if 
you price the job differently than the price list 
the difference will be displayed in Target 
Adjust. 
 

        Job Price  The total of all the prices shown in the window 
(unless the job price was overridden). 
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Estimator Checklist 

PrintSmith Vision includes an “estimator checklist” so you can review the entire job – from specification creation 
to production – in one place. The estimator check list has two sections, one for the item list and the other for the 
items table. 

One checklist is opened for each job in a document. The item list shows general information about the job; the 
items table provides details of the items that make up the job. Items that are red and underlined indicate 
conflicting information or information that was overridden and warn you to follow up.  

 

 

 

 

 
Price List 

Once the detail is entered you can create a price list. This is used for customers that are not sure of the quantity 

they want to order. 
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Roll-fed Job  

The Roll Fed job method is for jobs that are printed on an offset web press, for example, a newsletter printed in 
four colors on two sides. These jobs are based on roll-fed press definitions. 

Roll-fed jobs are identical to printing jobs (see above), with these exceptions:  

• The Roll Width is the width of the entire roll of stock. This comes from the stock definition and cannot 
be changed.  

• The Cutoff field specifies the circumference of the physical cylinder on the press, for example, 11 
inches. This comes from the press definition and cannot be changed.  

• By definition, there is only one pass on a roll-fed press, so Passes is always set to 1 (and cannot be 
changed.) 
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B&W or Color Digital Job  

 

 

The B&W and Color job methods are for black-and-white and color copy jobs. Much of the information for such 
jobs comes from the digital definition and stock definition selected for the job. For many jobs, a description and 
the number of copies ordered is all that is required to price the job. 

1.     Follow the general procedure for creating a job (see page 35) and select B&W or Color as the job 
method. (Your company may use different names for these job methods.) Then select a stock and make any 
necessary changes in the Paper Calculator window (see page 40).  

2.     In the Description field in the Job window, enter a name for the job, for example, Color Copies.  

3.     Tab through and complete the fields on the right side of the Job window:  

a. In the Ordered field, enter the job quantity. For information about specifying more than one 
quantity for a job, see page 37.  

b. If you want to charge for the difference between the ordered quantity and the quantity actually 
delivered, in the Overs/Unders field, enter a positive number if the delivered quantity is over the 
ordered one or a negative number if it is under. Overs and unders typically apply only to jobs with 
large quantities involved.  

Notes  The total price of the job (including all charges)is divided by the quantity ordered to get a unit price. 
The unit price is then multiplied by the quantity entered in the Overs/Unders field. This is added to the job price 
and the total job price.  

Any job that has overs or unders defined is shown with the quantity and price italicized.  

c. The In Sets of field typically applies when carbonless or NCR stock is being used for the job, 
and indicates the number of sheets in a set, for example, for 3-part NCR, enter 3 in the In Sets of 
field. Otherwise, this field is not used.  

Tip   For an item like pads, enter the total number of items in the Ordered field. For example, if you need 
100 pads of 25 pages, you would enter 2500 in the Ordered field and 1 in the Sheets field. You would then use 
charge definitions to make the pads themselves. 

   d. In the Sheets field, enter the number of originals or number of versions (see examples below).  
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Notes  In certain kinds of jobs (such as booklets), sheets are equivalent to leaves. When entering a value 
in the Sheets field for jobs like these, keep in mind that you are always describing the finished product.  

Example 1: In a job for a set of single-sided copies, Sheets is the number of originals. If you are making 100 
copies of 10 pages, Sheets would be set to 10. (If the job is double-sided, Sheets would be set to 5.)  

Example 2: In a job for four different versions of a single-sided flyer, Sheets is the number of versions so should 
be set to 4.  

Example 3: In a job for a 100-page comb-bound booklet, Double-Sided would be selected and Sheets would be 
set to 50.  

Example 4: In a job for a 16-page booklet which is the result of folding the paper in half and saddle-stitching, 
Double-Sided would be selected and Sheets would be set to 4. (4 double-sided sheets folded in half and 
saddle-stitched result in a 16-page booklet.)  

e. The Up and On fields are automatically calculated but change them as necessary. Up indicates 
how many images fit on the run sheet. On indicates how many unique images (originals) you have. 
For example, if you are producing business cards with four different names, On should be set to 4.  

f. The number Ordered divided by the number Up results in the value in the Copies field (which 
may be rounded up). Change the value in the Copies field if necessary, but keep in mind that 
PrintSmith Vision will then change the number Ordered.  

g. Finishing operations (such as bindery) may have some associated waste. As you add finishing 
charges to the job, any associated waste is calculated and added to the Bindery Waste field. If 
necessary, enter a different number in the Bindery Waste field, but avoid doing this until you have 
added all finishing charges to the job.  

Note  When a finishing charge is defined in sets, the waste is the number of sets (not sheets) that are 
spoiled.  

h. In the Est Waste field, enter the number of sheets you expect to lose during the production 
process to get the required number (Ordered quantity) of good prints. Normally, Est Waste is set 
to 0, but you can override it (if you have permission to do so).  

Note  Usually, waste is added to the run length. This affects the estimated run time for the job and the 
amount of labor. When labor is a factor in calculating the price, the price changes to reflect this. If the stock cost 
is part of the price calculation in the digital definition (the Stock Price is field is either set to marked up Stock 
Cost or set to from Copier 1, 2, or 3 in Stock Definition), waste is included in the price.  

4.    The stock information and dimensions should be correct based on your stock selection and the 
information you provided in the Paper Calculator window. If you need to change the stock, click Change 
Stock Selection under Commands.  

5.    The Pricing Copier field defaults to the digital definition associated with the stock (if any) or your 
default B&W or color digital definition depending whether you are creating a B&W or color job. Select the 
correct digital definition for the job.  

The Costing Copier is the printer you want to use for costing if a job is quoted on a low-end printer but is 
run on a high-end printer. The price of the job stays the same, but your costs will be accurate if the high-end 
printer is used. Typically, you do not need to change this field.  

6.    Select Single Sided or Double Sided.  

7.    Add any setup and finishing charges to the job as described on page 66. For example, if you are folding 
and stitching the job, add a folding charge and a stitching charge.  

8.    Click Save to save the job. The document window opens with the job and its charges listed. 

Add/Modify Special Pages 

You may have pages that are different than the rest of the pages. It could be some color pages where the rest 
are black and white or it may be an insert. 
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Here you can define the special pages and add them to the job detail 

a. Enter the page numbers for the special pages 

b. Select the type of pages 

c. Enter the description 

d. Select the stock type 

e. Select the stock color 

f. Identify as Simplex or Duplex 

Selecting Print Services will allow you to enter some specific printing services. 

 

 

 

Large Format Job  

The Large Format job method is for jobs that are printed on a wide-format digital press. These jobs are based 
on large-format digital definitions. 

Large-format jobs are almost identical to B &W and color jobs, with these exceptions:  

• The stock selections (in the Stock Picker window) are limited to stocks used for large-format work.  

• The Cutoff is the length of the stock used for the job.  

• The Est Waste field is for specifying the number of prints (not square area) that you expect to waste to 
get the required number of good prints.  

• The Pricing Copier field defaults to the digital definition associated with the stock (if any) or your 
default large-format digital definition. If necessary, select a different large-format digital definition for the 
job. 

Charges Only Job  
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The Charges Only job method is for jobs that consist of just setup or finishing charges, for example, design 
work.  

1. Follow the general procedure for creating a job (see page 35) and select Charges Only as the job 
method.  

2.     In the Description field, enter a name for the job, for example, Design and Consulting.  

3.     If you plan to add more than one job aware charge, in the Ordered field, enter the job quantity. This 
quantity is then used automatically in all the job aware charges. Otherwise, leave the Ordered field 
set to 0.  

4.     In the Notes field enter any comments to explain the job.  

5.     Add the charges to the job as described on page 65.  

6.     Click Save to save the job.  

Job for Blank Stock  

The Blank job method is for selling blank stock. The prices for blank stock are taken from the Pricing for Blank 
Sheets area on the Pricing Options tab in the Stock Definitions window. 

 

Note  Blank stock pricing is based on the Blank Stock Pricing quantity and markups in your Stocks and 
Sizes preferences and the costs in the stock definition (the Cost row under Qty. Adjustments on the 
Specification and Pricing tab).  

PrintSmith Vision uses the blank sheet pricing to calculate a unit price and then multiplies this by the quantity 
ordered for the job.  

To create a job for blank stock  

1.    Follow the general procedure for creating a job (see page 35) and select Blank as the job method. Then 
select a stock and make any necessary changes in the Paper Calculator window (see page 40).  
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2.    In the Description field, enter a name for the job.  

3.    In the Ordered field, enter the quantity and press the TAB key. The Unit Price and Price are calculated 
according to the blank stock pricing in the stock definition.  

4.    Click Save to save the job. 

 

List Based Job  

The List job method is for print jobs based on list pricing. List prices are tables of quantities and either numbers 
of colors or numbers of passes through the press. PrintSmith Vision includes some list price schedules to get you 
started. You can change the contents of the schedules or delete them as long as at least one is left. (There must 
always be at least one predefined price schedule.)  

Note List pricing is useful if you need to match another pricing system or a printed price list exactly, but 
you do have to enter and change the prices manually.  

If you use Crouser pricing, see the guide PrintSmith Vision - Crouser Pricing. Crouser list price schedules work 
very much like the standard list price schedules described here except that you cannot edit or delete them.  

If you create jobs based on list pricing, you can (but do not have to) assign price list schedules to stock 
definitions. When you select a stock for a list-based job, and the stock has a list price schedule associated with it, 
that list price is used for the job. Otherwise, PrintSmith Vision warns you that the default price schedule will be 
used. You should then select a list price for the job.  

Before you can create jobs based on list pricing, you must create your list price schedules or review and adapt 
the predefined price list schedules.  

Creating list price schedules  

Select Pricing > List Price Schedules. The List Price Schedules window opens. 
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To create a list price based on quantities (copies) and number of colors, click New Color Schedule. A window 
with Colors at the top opens. 

Alternatively, to create a list price schedule based on quantity and number of passes through the press, click 
New Pass Schedule. A window with Passes at the top will open. 

To complete the price list information: 

1.   In the Name field, enter a descriptive name for the schedule. 

2.   By default, the price list is based on the ordered quantity, but if necessary, select one of the following in 
the Method field:  

• Use press sheets – the run quantity of sheets through the press.  

• Use press sheets and bindery waste – all the paper running through the press.  

• Use ordered quantity per sheet (originals) – the ordered quantity for each original, for example, 
25 business cards for each name.  

 

3.  Enter your quantities and prices in the table. Note that the fields below the table are used for whatever  
          additional increment that you specify; +1000 in the example below.  

 

4.  Click OK 
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Modifying list price schedules  

EFI recommends that you review the pre-defined list price schedules and adapt them to your needs.  
1. Select Pricing > List Price Schedules. The List Price Schedules window opens.  
2. Double-click the list price schedule you want to review or edit (or select it and click Select). The list 

price schedule opens.  
3.    Edit the schedule as necessary and click OK.  

Copying list price schedules  
1.    Select Pricing > List Price Schedules. The List Price Schedules window opens.  
2.    Double-click the list price schedule you want to copy (or select it and click Select). The list pric 
       schedule opens.  
3.    Select File > Save As and provide a name for the new list price schedule.  
4.    Edit the schedule as necessary and click OK.  

Deleting list price schedules  
You can delete any list price schedule, but the system must always include at least one list price schedule so 
that a default exists.  

1.    Select Pricing > List Price Schedules. The List Price Schedules window opens.  
2.    Select the list price you want to delete click Delete.  
3.    Click Yes to confirm the deletion.  

Assigning list price schedules to stocks  
When you use list pricing as the job method, your stock definitions can be (but do not have to be) associated with 
list price schedules. When a list price schedule is associated with a stock that you select for a list-based job, the 
list price schedule is used to price the job. If the selected stock does not have an assigned list price schedule, 
you are warned that the default list price schedule will be used for a list-based job; you can then select a list price 
schedule for the job.  
Note The default list price schedule is the first one listed in the List Price Schedules window.  

To assign list price schedules to stocks  
1.    Open a stock.  
2.    In the Stock Definitions window, click the Pricing Options tab.  
3.    Under Schedule for List Pricing, click Select Schedule and make your choice. The name of the  
       schedule is now displayed to the right of the Select Schedule button.  
4.    Save the stock definition. 

 

Creating jobs based on list price schedules  

When you select List as the job method, a list price schedule must also be selected. If the stock you select for 
the job is associated with a list price schedule (see above), that schedule is used (although you can change it). 
Otherwise, you must select a schedule while creating the job. 

Follow the general procedure for creating a job (see page 35) and select List as the job method. Then select the 
stock.  

1.    In the Description field in the Job window, enter a name for the job.  

2.    If you were warned that the default list price schedule will be used, select a different schedule.  

3.    In the Quantity field, enter the quantity ordered. If the schedule is based on colors, the initial calculated     
price is based on one color on the front. For passes through the press, the price is based on one pass.  
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4.    In the area below Costing Press, for a schedule based on colors, enter the number of colors on the 
front and back as shown in the figure below. (If the schedule is based on passes, enter the number of 
passes as necessary.) The price of the job is automatically updated based on the information in the list price 
schedule selected for the job.  

 

5 Click Save. 

 

Outside Service Job  

The Outside Services job method is for jobs that you send out to other vendors, not do in-house. Such jobs are 
also known as brokered or vended jobs. An outside service job is marked up according to your outside services 
markup preference (Admin > Preferences > Estimator > Markups). (You can always adjust the markup as 
market conditions change.)  

Note  Jobs are not identified as outside service jobs on estimates or invoices so your customers will not 
know these jobs were sent out.  

If purchase orders are enabled in your system, you can create a purchase order for the outside service. 

1. Follow the general procedure for creating a job (see page 35) and select Outside Services as the job 
method. (This may have a different name in your shop.) 

2. In the Description field, enter a name for the job, for example, Design Work for Spring Promotion. 

 

3.    In the Notes field enter any comments to explain the job. These notes are for the outside service 
(vendor) and are not shown to the customer unless you select the Show Notes check box.  

4.    In the Vendor field, select the vendor you are using. (Use Table Editor to maintain your list of vendors in 
the Vendor table.)  

5.    In the Quantity field, enter the number ordered.  

6.    Do one of the following:  

• In the Unit Cost field, enter the cost of one unit of the item you are having done. The system then 
calculates the Total Cost by multiplying Unit Cost by Ordered (quantity).  

• Enter the Total Cost. (No Unit Cost is calculated in this case.)  
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Note  The Price is Total Cost multiplied by the Markup.  

7.    Click Save to save the job.  

Note  If you activated any of the five Merch pricing methods (in the Pricing Method preferences), they 
work just like the Outside Services method. Typically, the Merch pricing methods are used to group outside 
services by different sales categories. 

Merchandise Job  

The Merchandise job method is for any kind of work that is not accounted for by one of the other job methods. A 
merchandise job is marked up according to your merchandise markup preference (Admin > Preferences > 
Estimator > Markups).  

1.    Follow the general procedure for creating a job (see page 35) and select Merchandise as the job 
method. (This may have a different name at your shop.)  

2.    In the Description field, enter a name for the job, for example, Frames.  

 

3.    In the Notes field enter any comments to explain the job. These notes are not shown to the customer 
unless you select the Show Notes check box.  

4.    If applicable, in the Vendor field, select the vendor you are using. (Use Table Editor to maintain your list 
of vendors in the Vendor table.)  

5.    In the Quantity field, enter the number required. For information about specifying more than one 
quantity for a job, see page 37.  

6.    In the Unit Cost field, enter the cost of one unit of the item you are selling.  

Note  Total Cost is the Unit Cost multiplied by the Quantity, and the Price is Total Cost multiplied by 
the Markup  

7.    If necessary, add charges to the job as described on page 65.  

8.   Click Save to save the job. 

Multi Part Job 

The Multi-Part Job pricing method is for complex jobs that include sub-jobs. For example, you have an order for 
a booklet that has a cover and a number of inside pages. The cover might be a process color job on coated stock 
while the inside pages might be photocopied. The cover may need negatives, stripping, plates, scoring, and so 
on, while the inside pages are a simple copy job. Since the jobs are related, you want to keep them together. 
Some charges would apply to the entire job (for example, collating or binding) while others (for example, 
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embossing the cover) would apply just to the cover job. Similarly, you might have an order for an unusual banner 
that involves three separate jobs: printing the banner itself, sending it out to be sewn, and sending it out for 
installation.  

After you select the Multi-Part Job pricing method, you first provide some general information about the overall 
job, after which you add the individual jobs that make up the parts of the overall job.  

To create a multi-part job  

1. Follow the general procedure for creating a job (see page 35) and select Multi-Part Job as the job 
method.  

2. Select the product. In the Product field, select the type of product the job represents. (You can use 
Table Editor to define product types in the Products table.)  

Note  If Product Type for Job is selected in the Mandatory Field preferences, the Product field 
is outline in red. You must select a Product before you can save the job.  

3. If necessary, change the settings of the Brokered or Finished check boxes. (Brokered is automatically 

selected if you create a job based on the outside service pricing method.) Identify if the job is Finished 

4. If you are using Tracker, in the Location field, select the area where the job takes place. 
5. If the Product you select for a job is associated with a specific tax table (in the Products table), the Tax 

Table field is (with some exceptions) set to that tax table.  
6. If you are using Tracker, in the Location field, select the area where the job takes place.  
7. If you need to change the pricing method for the job, select it in the Type field. (Other fields in the Job 

Window will be affected by your selection.)  
8. In the Comment field, enter any notes about the job. 
9. Enter the description. The job method will default into the description field but it can be edited, removed 

or added to. 

10. Enter notes about the job. You can check the box to have notes included in documentation and invoice. 

11. You can add charges for the overall multi job in addition to the charges that may have been added to 

individual job parts. 

12. Finishing operations (such as bindery) may have some associated waste. As you add charges to the 
job, any associated waste is calculated and added to the Bindery Waste field. If necessary, enter a 
different number in the Bindery Waste field, but avoid doing this until you have added all finishing 
charges to the job.  

Note  When a finishing charge is defined in sets, the waste is the number of sets (not sheets) that are 
spoiled.  

13.  In the Est Waste field, enter the number of sheets you expect to lose during the production process to 

get the required number (Ordered quantity) of good prints. 

Note As you complete each job part be sure and select Confirm. This will add the job charges to the 

multi-part job. 

Each part of the multi part job can be different job methods and are defined when you create the part. Use the 

“Add Part” button to add each part to the job.  

When you select add a job, you will be taken back to the add job screen where you can select the job method for 

that part. After adding a job, you can select the Go to Job Details button and you will be taken back to the multi-

job page where you can see all of the job parts and charges, including charges added to each job part. 
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Free Style Job 

 

There may be times when you do not need a job ticket or estimate and just want to produce an invoice for the 
customer. For a free style job all you enter is the job description, quantity and price. 

  

Create Job from Account History 

If you select Account History, then you will see a list of account historical invoices or you can select from historical 

estimates. This is helpful for reprint jobs where the price may or may not have changed. You can narrow the 

search by using the search fields at the top of the list to select from the posted date, invoice or estimate number, 

description, cost or sales rep.   

 

 

 

You will then see a new screen with the information from the historical invoice or estimate.Select the one you 

want and then select NEXT. This will take you to the estimate summary screen. If the prices have changed since 

the invoice or estimate was originally created you will be given the option to update the price definitions. 

 

  

 

You can select the product from the drop down list.  
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The quantity will default from the original estimate or invoice but you can change it. The price will automatically be 

recalculated based on the new quantity. If you need to make changes to the job you can select the job detail tab 

and make changes there. For more informatiuon on the job detail screen see the prior section on the job method 

that is appropriate. 

 

 

   

  Create Job from Templates 

In the section on create from there are two views with different options. If you choose to use template     
categories then you only see the options of Create New Job, Account History and Templates. If you do not use 
template categories, then in addition to the others you will see the option of Job Templates. The check box for 
Template Category View is under Preferences > HTML View. 

Without the Template Category View you can choose from Job Templates or Templates. For either one you can 
then select invoice or estimate templates. 

 

If you select job templates you will see all of the job methods and as you select the job method you will see the 
templates that have been set up for that job method. 

 

If you select for the Template Category View then when you select Template you will be shown the list of 

template categories. You can select to show all templates or select a specific category and then you will see only 

the templates for that category. 

You can also use the column headings to search for specific templates, just start typing in the selected field. 
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You can create a template category from the template list (see page 17) or when you create a template from an 

estimate on the estimate summary screen (see page 64) 

 

After selecting the invoice or estimate template, the new estimate screen is opened. If there has been a price 

change in any of the operations or material since the original invoice or estimate was done you will get an alert 

and you can decide to have the new estimate updated with the new price or keep the old price. 

  

Account information 

You should always review the information in this window, provide any missing information, and make any 
necessary corrections.  

Note  If any account or contact fields are required (as specified in the Mandatory Field preferences), you 

must provide this information before continuing. This applies to the walk-in account, too. If there is a Red box 

around the contact area that indicates that there is some missing information regarding that contact. User will not 

be able to proceed until the mandatory information is filled. 

Review the Invoice Address; if necessary, click Edit to change it. Doing so changes the address only in the 
document, not in the customer account. 

Note  You can change the account name and address if Can change address on ALL documents 
preference is selected in the Estimator Behavior preferences (Admin > Preferences > Estimator > Estimator 
Behavior).  

The Contact field includes information about the invoice contact from the selected account. If necessary, do one 
of the following:  

Note  A temporary contact is not added to the customer account. In addition, if PrintSmith is integrated 
with SugarCRM, temporary contacts are not sent to Sugar. For more information, see the PrintSmith Vision – 
SugarCRM Integration Guide.  

• If the contact you want to specify is not in the Contact List, add one by clicking New (or by selecting 
File > New) and completing the Edit Contact window. This new contact is added to the customer 
account when you save the document. 

 

  

Add 
Contact 

Edit contact 
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Account Status and Type 

You can identify the status of the account and the types of payments that will be accepted from that account. 

Invoice and Delivery Address 

In addition to the contact information you will also se the invoice address and delivery address. The invoice 

address cannot be changed from this screen and must be changed in the customer account information. From 

the Quick Access Screen in the Legacy version select account and the select the account from the provided list 

and then you can change the invoice address using the edit option. Changing the invoice address in the customer 

account will not change the address in the estimate account information. You will need to create a new estimate. 

 

 

 

You can change the delivery information by either selecting from Contact list if there are other contacts already 

set up or you can enter a new delivery. To enter a new delivery address select the optio of Other and that will 

then open the option to edit delivery. 

 

 



   Estimating |   63 

 

 

 

 

Internal Information 

 

There is also some internal information that is needed for this invoice. 

 

 

 

1. The Taken by field identifies the person who created the document (based on the user name entered to log 
into PrintSmith Vision). If necessary, change this name.  

Note For better job tracking always log in as yourself; do not share your login with other users.  

2.  If you selected an account for the document, the name of the sales representative associated with the     
account is displayed in the Sales Rep field. If necessary, select a different representative.  

3.  If necessary, in the Hold field, select a hold state if the job needs to be held or the customer is on credit hold. 
You can see hold information in the Work in Progress report (see page 120 for more information on WIP). 
(You can edit the Hold State table with Table Editor to include the kind of states that apply to your business.)  

4.  If necessary, select a Lead Source. (You can edit the Lead Source table with Table Editor to include the kind 
of leads that apply to your business.)  

Note  When you convert an estimate to an invoice the selection in the Lead Source field is kept; if you copy the 
document to a new invoice or estimate, the value is not kept.  

5, If necessary, in the Proofreader field, enter the name of the person doing the proofing. 
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Missing Information Warning  

If any information is missing you will see a warning and the area for the missing information will be outlined in 
red. 

Note Until user adds the missing information they will not be allowed to switch to another tab. 

 

Estimate Summary 

There are several features available from the estimate summary screen. 

 

 

Add Free Style Item                Copy                  Email Estimate 

Add Job               Save as Template    Estimate Notes 

Add Charge 

      

 

Adding Free Style Items, Jobs or Charges to an Estimate 

 

Add Free Style Item 

Sometimes you may have a situation where a customer is ready to place an order but they do not want to wait 

while you enter all the information needed to create a job. This works well if it is something basic such as a 

business card or stationary where you know the price and the specs. You can provide the customer with an 

invoice and then later fill in the job specifications. In this situation, you will select ‘Add Free Style Item’ 

• To enter a Free Style Item: 

• Select the product 

• Enter a description 

• Enter a quantity 

• Enter the item total charge. The unit price will be calculated form the quantity ordered and total cost 

• Select if the line item is to be taxed or not. 

 

After adding Free Style job and saving the estimate you will get the option to convert to job. The Price of the 
Free Style job is automatically locked. To make changes to the job you will need to unlock the item by clicking 
on the lock. 



   Estimating |   65 

 

 

 

 

 

 

After converting the job, you will be directed back to the job detail screen. On the job detail screen, you can 
change the job method and add the required job information, you can also mark the job has Finished and 
Brokered.  You can add charges to the job. 

Note User is not allowed to Add charges to Free Style job before saving and converting to a job. 

However, once the job is converted you can add the charges. 

 

        

    Add job 

Adding a job will take you a screen where you can select how you want to add a job. It has all the same options as 

the original new job screen. 

      

 

See the information on “Adding a job” starting on page 65. After adding the job, it will be reflected in the total 

estimate.  

     Add Charges 

Charges are set up in the Legacy version. Go to Pricing > Charge Definitions. 
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Note  When you are adding charges or modifying any existing charges, make sure to click on Confirm 

button and Done button to save the charges to the Estimate. 

 

 

Save as a Template 

 

1. Select if you are creating an estimate or job template. 
2. Enter the template name 
3. Select the template category from the dropdown. 

If you create a job or estimate and anticipate using it in again you can create a job or estimate template. A job 
template consists of a single job and all the setup and finishing charges for that job. An estimate template 
contains all of the information from the original estimate. Templates can be used many times. You can create an 
estimate from a template and then make changes to that estimate as needed.  

You can also create templates for multi-part jobs. In this case, the template contains the overall job, its charges, 
and the parts (jobs) that make up the overall job, as well as their charges. For any repetitive jobs, templates save 
time and reduce errors.  

Note To see how to “Create Template Categories” see page 17. 

Templates can also be associated with customer accounts (on the Templates tab in the Customer window). This 
facilitates the process of selecting a template when working with an account. 
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Copy to a new estimate 

This option allows you to copy the entire estimate over to a new estimate. You will get a warning if you have not 
saved prior to copying. 

Email Estimate 

Selecting this option will first save the estimate if it is not already saved and then open an email window with a 

preset message. 

 

 

Estimating Notes 

You can enter estimating notes 
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Print Estimate 

 

Note:  Estimate must be saved before printing. If you select print estimate before saving the program will 

save the estimate automatically. 

 

You can also define the style to be used for the printing. 

 

You can print an estimate also from Pending Documents. 

Change Account 

You can change the account for the estimate. Click on the account name and then use the drop down to select 
the new account. You can also type in part of the name. 

Note Change account is only available from the Account Information screen or Invoice/Summary screen. 
The user must have permission to change an account. 

 

 

One portion of the estimate summary screen is minimized by default use the arrow at the bottom to display this 

portion of the screen.  

 

  

      Special Instructions 

        You can enter special instructions that will appear on the estimate. 

         

Sales Categories 

This shows the invoice sales breakdown for each sales category 

Note  The total for the sales categories comes from the invoice item total and not the invoice total that 
could include taxes, discounts or markups. 
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Dates 

 

 

You can mark the wanted date as firm and mark to file the originals. 

 

User can select\update the shipping method here from dropdown. 
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When the PO number is mandatory then the field would be highlighted so that user can enter the data, Warning 
is not displayed when an Invoice is saved. However, when user tries to pick up the Invoice the following warning 
is displayed.  

“Orders for this customer require a Purchase Order. Please enter a PO#.” 

 

Price Information 

The Price information area shows the estimate totals. To enter a shipping amount, enter or change a customer         
discount percentage, select a different tax table and tax code click Edit (plus sign after label) 
 

 

 

There are several options in the section for the price information section 

You can add a discount or markup by selecting the plus sign. It can be entered as a percentage or a fixed 
amount. 

 

 

 

Note   If the account had a one-time discount defined, and you indicated you wanted to apply it when you 
created the document, the discount is shown in the Discount Amt field, and the Apply one-time discount 
check box is selected. If no discount was defined, you can enter one now. 

 You can add a delivery fee. 

 You can add or change a sales tax by selecting the plus sign. 
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Selecting the No Tax check box will result in zero tax for the invoice/estimate. 

If the customer is taxable you can still identify which lines are to be taxed and which are not. 

Note:  At charge level user needs to open the charge and check if it’s taxable or not. Identification mark is 
not available 

 

 

 

You can also change the customers tax exemption status 

Command line option 

You can lock the price 

 

 

This locks the price for all items on the estimate. You can unlock the price for all items by changing it here. 

When the price is locked it will display a lock for each line item 

 

You can unlock the price for an individual item by selecting the lock 

        If there is a royalty associated with this estimate you can make it exempt. 

        Click Recalculate to update each job and charge in the document with the latest pricing information and then 

        recalculate the entire estimate. 

 From each line item you have other options. 

Specifying multiple quantities with different job specifications  

If you want to add multiple quantities for a job or want the ability to change job specifications for different 
quantities, use the Multi-Qty field in the Job window as follows:  
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When creating a job in an estimate, enter the first quantity in the Ordered field, provide other information about 
the job, for the next quantity in the same job, click + next to the Quantity field, click to add another quantity, enter 
the second quantity in the Ordered field, change other information about the job as necessary. Click Confirm. 

 
 

 
 
 
If you want to estimate multiple quantities from the estimate summary screen use the Add Multi Quantity option 
available for each line. 

 

 
 

You can edit the description using this icon to the right of the trash can 

 

Note If you have multiple lines on the estimate summary screen you can change the sequence of the 
lines by clicking and dragging the description. 
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Cost Tab 

Cost is the amount you spend to produce the order; price is the amount you charge your customer. The 
difference is your profit.  

Although PrintSmith Vision does not require you to enter your costs, without them you will not be able to see 
where you are making (or losing) money.  

You define costs in your pricing definitions:  

• For charges, costs are entered by clicking Costing in the Charge Definitions window. 

• For digital definitions, costs are entered in the Cost Plus area of the Digital Definitions window.  

• For stocks, costs are entered on the Specification and Pricing tab in the Stock Definitions window. 

 

Notes EFI recommends that you build most of your profit into labor rather than having very high stock markups 
to compensate for a printing labor rate that is too low.  

You can change costs in a locked document (one that is in history).  

After you select charges, stock, and a press or printer for an order, the costs associated with your selections are 
calculated as estimated costs. If you use Tracker, it will calculate actual costs for you; otherwise, you can enter 
the actual costs manually if they differ from the estimates. You can review the estimated and actual costs in the 
Costing window as described below. On the estimate summary section there is also a cost tab. The estimated 
cost, actual cost (once the job is complete), the difference, selling price and job margins is displayed for each line 
item. Cost is the amount you spend to produce the order; price is the amount you charge your customer. The 
difference is your profit.  

 

Entering actual costs  

Although PrintSmith Vision does not require you to enter your costs, without them you will not be able to see 
where you are making (or losing) money. 

To review or enter actual costs  
1. When a document is open, On Estimate summary tab click on Costing button. 
2. Review the costs. 
 

 
 

3.    If you know the actual cost then click the Actual column and enter the actual cost. Blue identifies costs 
that you entered. Red alerts you that an item was priced below cost. The margin will automatically 
recalculate. 
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If there are additional charges using the arrow on the left hand side will open the display to show those items 
also. 

 

 

Saving an estimate 

Until an estimate is saved, you will see the message at the top of the screen that the estimate is not saved. Make 

sure to save the estimate after any modification.  

 

You should then see the message that the estimate has been successfully saved.  

Note The message will only stay on the screen for a few seconds and then disappear 

   

      Once the estimate has been accepted you can convert it to an invoice. 
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                        Invoicing 

Creating Invoices  

As mentioned earlier several of the screens, features and methods of creating an invoice are the same as 
creating an estimate. 

The steps for creating a new invoice that are the same as creating an estimate are 

• Selecting the account (See page 33) 

• Creating a new job (See page 35) 

• The only option available in invoicing that is not in estimating is the ability to print the job ticket. (See 
page 79) 

• The accounting tab is the same (See page 61) 

• There are some differences in the summary tab and those will be discussed below. 

• The costing is handled like it is in estimating. (See page 73) 

 

Invoice Summary 

 

On the invoice summary screen there are several command options. You have the option to add to the new 

invoice items that were not on the original invoice or not part of the job specifications. You can add a freestyle 

item, a job or a charge. You can also copy everything to a new invoice at this level. 

 

  

  

      

 

Add free style, add job, add charges, save as a template, copy, email and print invoice are all the same as in 
creating an estimate. See this information beginning on page 33. 

 

 
 

 

  

Add Free Style 

Add Job 

Add Charges 

Copy Invoice 
Notes 

Email 
Invoice 

Print Job 
Ticket for 
Invoice 

Raise PO 
for Invoice 

Save as 
Template 
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Raise a PO 

If you need to have an outside purchase for part of all of the job, then you can create a purchase order. 

Selecting Raise a PO will take you to a screen where you can enter the information about the purchase. 

  

 

You can select the vendor from the drop down. 

 

NOTE In order for a vendor to be displayed for a PO they box labeled” use for purchasing” in the vendor 
record must be checked. 

NOTE You must enter the wanted date before you can email or print the PO. If you are going to email then 
you must have an email address in the vendor record. 

 

When you add a line to a PO you will get a new short cut menu screen where you can enter the information for 
the new line item. 

Add a Line 
Item 

Create a 
New PO 

Email Print 



Invoicing |  77 
 

 

 

 

 

Once a purchase order is saved you can access it again using this feature. 

 

 

For each line item you can edit it, mark as complete or delete the item 

 

You can also use the check box next to the items to Delete or Mark as Complete. If you check the box above the 
items it will select all items. 
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You can have multiple purchase orders for one invoice. Just create the first PO, enter the information including 
the due date and save. Then you can create another PO by using the NEW button. Then all of the purchase 
orders will be listed and available. 

 

 

 

 

 

Selecting the pencil icon will allow you to edit either the bill to or ship to address. 

 

 

You can also raise a PO for a line item. 

 

 

Invoice Notes 

Selecting this option will give you a short cut menu where you can enter notes on the invoice. These are internal 
notes and will not show in the invoice. 

Email Invoice 

Selecting this option will save the invoice if it is not already saved and then open an email window with a preset 
message.  
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Print job Ticket for invoice. 

This option will print job tickets for all the jobs on the invoice. 

Resequencing line items 

 

You can now re-sequence the line items by clicking and dragging the description. 

 

In the second screen shot you can see that the courier was moved down to after hand folding and drilling was 
moved above hand folding. 

 

 

 

If the customer is taxable you can still identify which lines are to be taxed and which are not. 
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Sales Format 

        This displays the different options of how the invoice will print when the print invoice button is selected. 

 

          

 

 
 

You can select\update the shipping method here from dropdown. 

 

 

 

If the customer has a resale number, it can be entered here.  You can enter the customers purchase order 
number. When the PO number is mandatory then the field would be highlighted so that user can enter the data, 
Warning is not displayed when an Invoice is saved. However, when user tries to pick up the Invoice the following 
warning is displayed.  

“Orders for this customer require a Purchase Order. Please enter a PO#.” 

 

 

You can mark the due date as firm 
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One portion of the invoice summary screen is minimized by default  

 

 

 

Price Information 

 
The Price information area shows the invoice totals. To enter a shipping amount, enter or change a customer         
discount percentage, select a different tax table and tax code click Edit (plus sign after label) 
 

 

 

There are several options in the section for the price information section 

You can add a discount or markup by selecting the plus sign. It can be entered as a percentage or a fixed 
amount. 

 

 

Note   If the account had a one-time discount defined, and you indicated you wanted to apply it when you 
created the document, the discount is shown in the Discount Amt field, and the Apply one-time discount 
check box is selected. If no discount was defined, you can enter one now. 
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You can enter a delivery fee. 

You can add or change a sales tax by selecting the plus sign. 

 

 

 

Selecting the No Tax check box will result in zero tax for the invoice/estimate. 

You can also change the customers tax exemption status 

 

You can add deposit to the invoice 

 

You can add up to three deposits, identifying them by payment method and a reference number. 
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Command line option 

You can lock the price 

 

 

This locks the price for all items on the invoice. You can unlock the price for all items by changing it here. 

 

When the price is locked it will display a lock for each line item 

 

       You can unlock the price for an individual item by selecting the lock 

 

 

      If there is a royalty associated with this invoice you can make it exempt. 

Click Recalculate to update each job and charge in the document with the latest pricing information and then 
recalculate the entire invoice. 

Saving an invoice 

Until an invoice is saved, you will see the message at the top of the screen that the invoice is not saved. Make 

sure to save the Invoice after any modification. 

  

 

 

If this customer has “Require purchase order” enabled in Account setup then when you try to save the invoice you 

will get an alert that a purchase order is required.  

Note  Be sure to update all mandatory fields before saving the invoice 
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You will need to enter the customer’s purchase order number before saving. 

 

You should then see the message that the invoice has been successfully saved.  

Note The message will only stay on the screen for a few seconds and then disappear 

  

 

Delivery Ticket  

 
On the invoice summary screen in the line item you can access the delivery ticket 

 

                
 
 
 

  
 
       Here you can verify delivery address, change the location of the item and mark it as shipped 
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You can also enter the shipping information 

 

  
 
 

You can also produce a new delivery ticket, print a packing slip and shipping label. 
 

 
 

You can search for a different delivery ticket through search option provided at top of the window 
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When you search for a delivery ticket you will be taken to that ticket in pending documents. 

 

 

The delivery ticket allows you to change the location of the product and mark it as shipped. 

 

 

You can check the box for an item and then mark it as shipped. 
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Recording Notes About Orders   

When you are working in a document window, you can use the note pad to record notes related to an order. 
For example, if you are taking an order over the phone, you may want to jot down some notes so you can 
complete the document later. Similarly, if you purchased stock at a special discount and passed some of the 
savings onto the customer, you could record this. If the customer placed the same order again, and the stock is 
priced normally, the customer might question the price. The note you recorded would remind you of the reason 
for the price difference. In addition, if you lock prices, you may want to note the reason for doing so. 

 

Note  You can change information on the note pad even if a document is locked.   

Except for the wanted by date (entered in the When field), none of the information you enter on the note pad is 
used in the document, but you can use the note pad to guide you in creating the job. The notes are saved with 
the document so you can return to them later when you have time.   

To record notes  

1. Click Invoice Notes on the toolbar in the document window. 

 

 

 

2. Enter or modify information in the note fields: Who, Phone, What, How Many, What Size, Paper, 

Notes, and When. (When corresponds to the wanted by date.)  

3. If you want the note pad to open automatically whenever you open the document, select the Show 

Note Pad when document opens check box.   

4. Click OK.  

 

Note  For detailed information on functionality please refer to PrintSmith Vision setup and User guide. 
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 Cash Register 

   Settings 

Customer Payment Options 

You can only use payment methods that have been approved for that customer. To access the set-up program 
for accounts, go to AR at the top of the main screen and then select Accounts. 

 

Select if you are searching for customers, prospects or contacts. 

Next select the account name 

 

This will take you to the screen where you can set up various customer preferences and controls. 

Under Credit Control you can set up the types of payments that are available to that customer.  

Note Be sure and save your settings. 
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If you have the customer set for cash only then the Cash Register program will show that as the default option. 
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Credit Card Surcharge 

You should also set up any surcharge you want to add when the customer pays by credit card. To get to this 
setting go to Admin > Preferences. 

 

 

Under Preferences select Credit Card Info. This will display a screen where you can set up different surcharges 
for different credit cards. These can be based on what your credit card processor charges you. This is not 
considered income since it is paid to the processor. The surcharge will apply for all customers. Be sure and save 
before closing. 
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Receiving Payment 

 

The first step is to identify the customer. You can enter a few characters of the customer’s name and it will show 
you those that fit. 

Next you will need to add invoices that are to be paid with the payment received. 

 

You will then be shown a list of the unpaid invoices for that account. Use the check boxes on the left to identify 
the invoices you want added to the cash register. After the selection use the Add to Pick Up button to place those 
invoices in the cash register 

 

If you know the invoice number, you can also enter it manually 

 

 Next select the payment method 
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Payment by Check 

Select the check payment method and enter the check number. The Amount Paying will default to the total of the 
added invoices. 

 

 

After you select the Receive Payment button you will get the option to print a receipt, select the print format for 
the receipt or email the receipt. When that is complete, select Post. 

Each invoice will print a separate receipt and when you are finished with them you will get an information 
message that the transaction processed successfully. 

Payment by Cash 

The only difference in receiving a cash payment is if you are in a country where cash is rounded to the nearest 5 
cents. This is set up under Admin > Preferences > International. Check the box for Use Australian Cash Register 
Rounding. This will cause cash receipt to round to the nearest 5 cents and any difference will show in rounding. 

 

 

 

When paying by cash it rounds the 94.93 invoice to 94.95 with .02 going to rounding. 
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Payment by Credit Card 

You can use CardConnect® as your card processor. For more information on use CardConnect® see the 
document for CardConnect® Integration. CardConnect® is a third-party credit card processing company. For this 
document we will go through the steps of using a credit card regardless of the system you use to process the 
card. In the case of CardConnect® a reference number will be supplied directly to the cash receipts program. In 
other cases, you will need to enter the reference number you get from you credit card processing company. 

You can select the credit card type and then enter the reference number. To get the reference number you need 
to go to your merchants account screen and make the payment. You will get a reference number or approval 
number that is then entered in Cash Register. 

After entering the reference number select Receive Payment. 

  

If you try to process the payment before entering the card transaction reference number you will get a warning 
that the card will not be processed.   

 

Charge Accounts 

A transaction can be charged only if a customer account is selected for the transaction and the account allows 
charges. This type of transaction is called a POS charge. A POS charge commonly occurs when a regular 
customer comes in, makes a small purchase, and asks you to charge it to his or her account. It is neither cost 
effective nor efficient to create a standard invoice for a small amount. Furthermore, you do not want the account 
history full of small transactions because it makes the history less useful. To see how to set up the account to 
accept charges and to set the credit limit for the account see the Payment Options set up starting on page 88. 

PrintSmith Vision maintains a special balance, called the merchandise charge balance, in each account for these 
small POS charges. These charges do not appear on statements. At the end of the month or some other suitable 
occasion, you should use AR > Post POS Charges to print a special statement composed of all POS charges. 
As part of this process, PrintSmith Vision makes a single entry in Accounts Receivable for the entire amount in 
the merchandise charge balance so the payment can be posted and included on statements.  

You can set up charge accounts for customers and then you can charge the invoice to those accounts. Charge 
an account does not impact your AR, you will need to post payments for the charged amount in the Post 
Payment application. 

Select Receive Payment and that will give you a new screen where you can Post the charge. 

When the customer pays their charges you will use Post Payments to process that payment. 

Department Charges 

In addition to invoices you can add department charges. These are typically items purchased that are not part of 
the job such as boxes. To create a department charge go to Preferences > POS > Cash Register in the Legacy 
version. Here you can create a department charge by entering the name, selecting the sales category, enter the 
charge for the item if you want and selecting the taxing method. Be sure and check the box to the left of the 
charge so that it will be available. 
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 To add a Department Charge, fill in the information on the screen and select Add. If the price is not already 
defined you will need to enter the unit price and the quantity. 

 

Once you have identified the method of payment and selected Receive Payment you can print or email a receipt 
and Post the payment.  

Regardless of the payment method you have the option to print or email the invoice to the customer. You will 
also have the option to use the customized email and attach the invoice and receipts. See page 21 for 
information on created customized emails and how you can automatically have invoices and receipts attached to 
that email. 
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Post Payments 

Applying Payments to Invoices  

If you picked up and posted an invoice under Cash Receipts and charged that invoice to an account then later 
when the customer pays for that invoice, you must apply the payments against the invoices so they are recorded 
as Accounts Receivable receipts. This process reconciles the money you received with the money that was due 
(as recorded in your invoices). In PrintSmith Vision this is known as posting payments.  

Why posting payments is important  

A common mistake when first getting started with PrintSmith Vision is to enter payments while picking up 
invoices without applying them to invoices. This has some undesirable side effects:  

• Invoices that were paid are still shown as open and may cause the account to become past due when it 
really is not.  

• The list of open invoices can get long making it more difficult to find an invoice to apply payment to it.  

• Customers may not understand statements that include invoices they think they paid.  

• The receipt is considered “on account,” and is not included as a taxable cash receipt in Accounts 
Receivable.  

Posting payments  

To post payments first select the account. This will then display the invoices that have been charged to that 
account.  

 

 

After you select the customer you will see the invoices that have been charged to their account as well as their 
status. If you want to see more detail about the invoice, select Properties. In properties you can edit the 
description. You can also edit the description from the line item by selecting the pencil to the right of the three 
dots. 

Next select the payment method they are using. Only the payment methods you have approved for that customer 
will be available options.  

Notify 
Customer/ 
Follow Up 

Clear 
and 

refresh 
the 

page 
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Selecting Invoices for Payment 

After the payment method has been selected you have several options as to how to record payments to the 
invoices. This is the same process regardless of the payment method selected but some of the payment 
methods will need additional information that is discussed in the portion for each method. 

1. Using the check boxes to the left of the invoices you can select the invoices to be paid and then select 
“Calculate Payment”. The program will enter the amount paid on the selected invoices in the right-hand 
column labeled PAY and enter the total of those invoices in the amount receivable. 

Note If you select the top box next to REF it will select all invoices. 

2. You can enter the payment amount in the Amount Receivable field and select Auto Apply and the 
amount will be applied to the oldest invoices first. 

3. If the customer is making partial payments to invoices, then you can select the field for that invoice 
under pay and a field will open to allow you to enter the amount of payment for each invoice. Then 
select Calculate Payment and the total will be entered in the Amount Receivable field. 

Tip   You can select invoices before you enter an amount and then click Calculate Payment on the 
toolbar, so the Amount is calculated automatically. 

Payment Method 

Payments by Cash 

Enter the amount of cash received and you can either use Auto Apply or select the individual invoices to which 
the payment is to be applied. 

Payment by Draft 

Enter the reference number you received from the bank and then proceed to identify the invoices as the 
procedure above outlined. 

Payment by Check 

Enter the check number and then select the invoices. 

Payment by Credit Card 

If you are manually processing the card outside of EFI PrintSmith Vision you will select the card type and enter 
the reference number you got from your card processor. 

If you are using USA ePay or CardConnect® then select the card icon to the right of the reference number field. 
You will then get a pop-up box where you can either manually or automatically process the card depending the 
option chosen. If you are not given a reference number you will need to enter one. 

For more information on using USA ePay or CardConnect® see the documentation on those specific processes. 

After selecting the payment method and the invoices select Post Payment. If the customer still has an amount 
due the program will default to the remainder going on account. If the customer overpaid on the total amount 
due, then you will need to select how the refund is to be handled but using the dropdown for that field. 

Handling refunds  

If a payment is greater than what the customer owes, the Remainder field in the Post Payments window lets you 
indicate how you want to handle the overpayment.  

• You can select one of the following in the Remainder field:  

• On account: The overpayment is not refunded but is posted to the account as an unapplied credit.  

• Return cash: Cash is refunded and subtracted from the cash total in the PrintSmith Vision “cash 
drawer.”  

• Write check: A check is written. Since PrintSmith Vision does not handle check writing, it records only 
half the transaction. It adds the refunded amount to the account balance and the AR balance, but does 
not record a negative receipt. Instead, a special refund check is shown during daily closeout and is 
printed on the deposit ticket. The Daily Sales report includes a Refund Check category to show the total 
amount of refund checks during the period.  
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• Credit card refund: A negative amount is applied to a credit card. This is recorded in the cash drawer 
credit card category and is a separate item in daily closeouts.  

• Direct Deposit: You will need to enter the reference number of the deposit. 

Note  The remaining selections in the Remainder field are credit card refunds for a specific card.  

Issuing a refund for overpayment  

Problem: You receive a check from a customer to pay for a group of invoices, one of which was already paid. 
You agree to send the customer a refund check.  

Solution:  

1.   In the Post Payments window, enter the amount of the check as written.  

2.   Select the items that are to be paid.  

3.   In the Remainder field, select write check. This refunds the amount of the overpayment with a check,  
which you must write later. (Checks are not written in PrintSmith Vision.)  

4. Click Post.  

Alternatively, if your customer agrees, you can leave the overpayment on account and apply it to later sales; this 
is the recommended method as no special action is required. You can access the screen to make journal entries 
from here or you can use the quick buttons on the left of the screen. Go to accounting > AR > Journal entries. 
For more information on making journal entries see the section on journal entries beginning on page 98. 

The section on the lower left-hand corner of the screen gives you the option of printing a receipt or emailing the 
invoice. You can select the format to be use 

Issuing a refund on a paid invoice  

Problem: You receive a complaint from a customer about an order for which the customer already paid and 
agree to refund part or all of the order by sending the customer a check.  

Solution:  

1. In the Post Payments window, select the invoice that you are refunding and click Add Journal Entry. (For 
more information about journal entries, see page 98. 

2. Make the appropriate correction and click OK. The Post Payments window opens, and both the invoice 
and journal entry are highlighted.  

3. In the Remainder field, select write check.  

4. Click Post. 

To email an invoice to the customer  

If you have set up customer email formats, then you will see the option for customize email. For information on 
how to set up custom mail see page 22. 

To print a receipt 

a. Select the Print Receipt check box.  

b. Make sure a printer is selected in the Current Printer field on the toolbar. (This field is displayed only 
when the Print Receipt option is selected.)  

Note  By default, Current Printer is set to the printer selected in the cash drawer preferences (reference 
from flex side), but you can select a different printer if you have more than one receipt printer. All users who log 
into PrintSmith using the same browser will see the same printer selected. This printer is also automatically 
selected in the Cash Register and Invoice windows. If you click Restore Settings in the Post Payments window, 
the printer reverts to the default preferences.  
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Journal Entries 

General procedure for making journal entries  

This section provides general information about making journal entries and some examples of particular types of 
journal entries. 

1.  Select AR > Journal Entry. The Journal Entry window opens.  

Tip  In situations where you need to adjust a locked invoice, you can open the Journal Entry window 
directly from the Post Payments window.  

2. Complete the top part of the window:  

a. Depending on what you need to do, click Select Customer to select an account or click Select 
Invoice and enter the number of the invoice you want to adjust. In the case of an invoice, the account to 
which the invoice was posted is displayed, and a reversing entry for the invoice is set up. If all you want 
to do is write off an invoice, just click Update & Post.  

b. If you want to print a credit memo for the journal entry (for example, to give to a customer to show 
that you credited the account), leave the Print Document check box selected. The credit memo will be 
printed after you click Update & Post.  

c. If you want to e-mail the credit memo, select the E-Mail check box. For more information about e-
mailing credit memos, see page 99.  

d. Customize email. You have the option of creating a customized email. For more information on this 
see page 22. 

e. Leave the Affect Sales check box selected so that sales totals are updated as a result of the journal 
entry.  

Warning  A journal entry that does not affect sales can unbalance your books. The only time you 
should clear the Affect Sales check box is while entering beginning balances when first setting up the 
system, for a job the customer refuses at pickup, or if a customer’s check does not clear. If you are not sure 
whether sales should be affected, consult an accountant to learn if your sales need to be reduced, or if a 
deduction should be taken at tax time. 

f. Leave the Update Customer Statistics check box selected so that the customer’s sales statistics are 
adjusted when you post the journal entry. This is intended primarily as a means of adjusting total sales 
when you write off an invoice. The system also adjusts the document count used to calculate the 
average order and ratio of estimates to orders if you use the Select Invoice button to set up the entry.  

3. Review and/or change the distribution amounts (journal entry details) and the memo totals.  

Each distribution amount is added to the Sub-Total and the Tax Sub fields unless you override the Tax Sub 
amount. Sales tax is recalculated after each change. When Tax Sub does not equal Sub-Total, they are shown 
as overrides, and changes that you make in the detail fields do not change Tax Sub. You can either remove the 
override from the Tax Sub field by deleting it (PrintSmith Vision then synchronizes Tax Sub with Sub-Total) or 
you can manually adjust Tax or Tax Sub.  

Note  If you change Tax Sub so that it differs from Sub-Total, distribution amounts that you enter 
subsequently will update Sub-Total but not Tax Sub. Both Tax Sub and Tax are shown as overrides. This is 
useful when backward calculation does not generate exactly the amount you need, or when only part of the 
journal entry is taxable.  

You can ignore the distribution amounts and enter amounts in the totals section directly. If you enter an amount 
in the Sub-Total, Total, or New Balance fields, the rest of the memo is calculated backwards. This is useful if 
you already know what you want the end result to be.  

For example, if a customer has a balance of 72.46, and you want to write off the entire balance, you can enter 0 
in the New Balance field, and a memo is generated to arrive at that balance. In this case, the total amount of the 
memo is 72.46 (a credit memo). If the Taxable check box is selected, the system calculates the subtotal needed 
to generate a taxable amount that, when taxed and added together, equals 72.46. If the tax rate was 6%, the 
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subtotal would be 68.36 and the tax 4.10. If the Taxable check box is cleared, the subtotal is the same as the 
total.  

4. The Description field includes some default text; change it if necessary (up to 255 characters). This 
description is used in account history and in credit memos.  

5. If you contact the customer whose information you are viewing in the Journal Entry window, log the 
interaction and, if necessary, indicate that follow-up is required:  

a. Click the Notify icon. The Notify Customer window opens.  

b. Complete the Notify Customer window.  

6. In the Sales Rep field, select a sales representative if the journal entry affects the commissions earned by 
that sales representative.  

7. In the Comments field, enter a detailed explanation of the reason for the journal entry, for example, Bad 
check. The comment is included in printed credit memos.  

8. To change all positive numbers to negative numbers and all negative numbers to positive ones, click 
Reverse. For example, if you receive a bad check, you do not want to remove the record, but you do want to 
add back the debt to the customer’s account.  

9. To zero all fields in a journal entry that are not related to taxes, click Only Tax. Typically, this button is 
used when adjusting (adding or removing) tax from an invoice. Everything is zeroed except Tax Sub, Tax, 
and Total.  

10. To write off a percentage of some known amount, enter a percentage in the field to the right of the Calc 
Adjustment button, and then click Calc Adjustment.  

11. When the journal entry is set up the way you want, click Update & Post.  

12. If you initiated the journal entry from the Post Payments window (see below), you automatically return to 
the Post Payments window where the original entry and the journal entry are automatically selected and 
ready to be posted. Click Update & Post. to apply one to the other. 

Originating journal entries from the Post Payments window  

When you need to adjust invoices that are locked because you already performed a closeout, you can simplify 
the steps in making a journal entry by starting the process from the Post Payments window. 

1. In the Post Payments window, select an account.  

2. Select the invoice you need to adjust and click Add Journal Entry. The Journal Entry window opens, and 
information from the selected invoice is displayed in negative format, ready to be adjusted.  

3. Make the necessary adjustments and click Post. For examples of the types of adjustments you may want 
to make, see “Journal entry examples” starting on page 100..  

4. After you click Post in the Journal Entry window, the journal entry is added to the Post Payments window 
which re-opens automatically. Both the original invoice and journal entry are selected and ready to be 
posted. Click Update & Post to apply one to the other.  

You can print and email the credit memo. If you want to email you have the option of the standard email template     
of you can customize the email template.  

E-mailing credit memos  

When you post journal entries, you can e-mail the credit memo for the posted journal entry (and/or print the credit 
memo).  

In addition:  

• The invoice contacts for your accounts must have e-mail addresses.  
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• The E-Mail check box must be selected in the Journal Entry window before you post the journal entry.  

 

When you e-mail a credit memo from the Journal Entry window, it is sent directly (you cannot review it before it is 
sent). By default, the credit memo is sent to the contact for the invoice or the invoice contact for the account.  

If the Credit Memo log text field in the E-Mail preferences includes text, e-mailed credit memos are logged in 
the customer account (on the Log tab).  

If the Credit Memo log text field in the E-Mail preferences is blank, e-mailed credit memos are not logged.  

If the Use log text for subject and file name check box is selected in the E-Mail preferences, the Credit Memo 
log text is also used for the subject of the e-mails and the name of the PDF attachment (the statement). If the 
Use log text for subject and file name check box is cleared. 

For more information on credit memo email templates and custom email see page 21. 

Journal entry examples  

This section provides some examples of journal entries. Many of the examples assume you are familiar with the 
Sales Summary report. In this report, sales information is on the left and receipt information is on the right. You 
can use journal entries to adjust them both. (To run the report, select Reports > Daily Sales, select Sales 
Summary, and double-click the date for which you want the report. 

Tip   Remember that if you are creating a journal entry for a locked invoice, you can initiate the process 
from the Post Payments window as described in “Originating journal entries from the Post Payments window” on 
page 99. 

Writing off an invoice as un-collectable  

If a customer refuses a job, you must write off the invoice. The invoice still remains in the customer’s account 
history but is taken care of from an accounting perspective.  

1. In the Journal Entry window, click Select Invoice and enter the number of the invoice to be canceled. A 
reversing entry for the invoice is created.  

2. Make sure the Update Customer Statistics check box is selected.  

3. Click Update & Post.  

4. Select AR > Post Payments and then select the account with the bad invoice.  

5. Select the memo and then select the invoice. Alternatively, if these are the only two open items, click 
Auto Apply.  

6. Click Update & Post.  

Tip   To avoid basing a new invoice on the bad (refused) invoice, EFI recommends that you enter a note 
about the invoice in the account history to clarify it was a bad invoice.  

Writing off an entire account balance as un-collectable  

If a customer goes out of business, you must write off the entire account balance.  

1. In the Journal Entry window, click Select Customer and select the account you want to write off.  

2. Clear the Affect Sales check box.  

3. Enter 0 in the New Balance field. If the Taxable check box is selected, the entire amount due is treated 
as taxable sales. You must manually calculate the taxable amount if only part of the balance is taxable.  

4. Enter an appropriate description and click Update & Post. The journal entry is posted. At this point, sales 
are adjusted, a negative adjustment to new charges is made, and the account balance is 0.00. There are still 
open items, however, which you should “pay” off with the journal entry you just created.  
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5. Select AR > Post Payments and select the account you are writing off. There may be several open 
items. The last open item is a journal entry, the one you just created.  

6. Click Auto Apply to select all of the open items.  

7. Click Update & Post.  The account balance is unchanged, but there are no longer any open items.  

Handling a bad check  

If the customer gave you a bad check, you must make a journal entry to add back the debt to the customer’s 
account.  

1. In the Journal Entry window, click Select Invoice and select the invoice for which you got the bad check. 

2. Clear the Affect Sales check box since you did not sell the job.  

3. Click Reverse to turn all the negative amounts to positive ones (because you need to add them back as 
what the customer still owes you).  

4. Click Update & Post.  

Discounting a percentage of an invoice  

If a customer is unhappy with a job, you may want to maintain a good relationship with the customer by 
discounting the invoice by some percentage, for example, 10%. If a closeout was already performed, you must 
make a journal entry to account for the discount.  

1. In the Journal Entry window, click Select Invoice and enter the number of the invoice you want to 
discount.  

2. In the field to the left of the Calc Adjustment button, enter a percentage, for example, 10 and press the 
TAB key.  

3. Click Calc Adjustment, and all the amounts change to 10% of the original amounts.  

4. Click Update & Post.  

5. In the Post Payments window, select the original invoice and the memo you just created and then click 
Update & Post.   

Note  The invoice in account history will continue to show the original amounts.  

Giving a dollar discount  

If a customer is unhappy with a job, you may want to maintain a good relationship with the customer by giving a 
fixed amount back (rather than a percentage as shown above).  

1. In the Journal Entry window, click Select Invoice and enter the number of the invoice you want to 
discount.  

2. Select the sales category from which you want to take the money and enter the amount as a negative 
number.  

3. Delete the entries in all the other sales categories (so they are blank).  

4. Click Calc Adjustment, and the amounts reflect the fixed amount you applied as a discount.  

5. Click Update & Post.  

6. In the Post Payments window, select the original invoice and the memo you just created and then click 
Update & Post.  
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Removing tax from a posted invoice  

If you learn after a closeout that an invoice was taxed when it should have been tax exempt, you must make a 
journal entry to remove the tax. This also corrects your taxable sales and non-taxable sales.  

1. In the Journal Entry window, click Select Invoice and enter the number of the invoice to be adjusted.  

2. Click Only Tax. All of the details are cleared except for Tax Sub and the rest of the totals. Tax Sub is a 
special number used strictly for calculating tax. With Sub-Total set to 0.00, the only real amount is the tax.  

3. Click Update & Post. A credit memo is created.  

4. In the Post Payments window, select the original invoice and the credit memo you just created and then 
click Update & Post.  

Adding tax to a posted invoice  

If you learn after a closeout that an invoice was not taxed when it should have been, you must make a journal 
entry to add the tax. This also adjusts your taxable sales and non-taxable sales.  

Note  This procedure assumes that the document was made tax-exempt the recommended way, by using 
the No Tax button in the Document Totals window. If you marked each item in the invoice as not taxable, you 
must manually calculate the tax amount before using this procedure 

      1. In the Journal Entry window, click Select Invoice and enter the number of the invoice to be adjusted.  
2. The invoice was not taxable, so the Taxable check box should be cleared. If there were items in the 
invoice that are taxable, there will be an amount in the Tax Sub field. Select the Taxable check box to 
calculate the tax based on the document’s tax table.  

3. Click Only Tax. All of the details are cleared except for Tax Sub and Tax. Tax Sub is used strictly for 
calculating tax. With Sub-Total set to 0.00, the only real amount is the tax.  

4. Click Reverse. This changes the journal entry into a debit memo. All the amounts become positive.  

5. Click Post. Tax Sub is added to taxable sales. On the receipts side, Tax is added to tax on sales and to 
new charges.  

6. In the Post Payments window, select the original invoice and the debit memo you just created and then 
click Update & Post.  

Issuing a refund  

Suppose that you overcharged a customer in a cash register transaction, the customer paid, and you performed 
a daily closeout. If the customer returns and requests a refund, you must issue a credit memo and then refund 
the amount.  

1. In the Journal Entry window, select the account to be used for issuing the credit. An “In House” account is 
useful for these types of transactions.  

2. Enter the amount of the refund as a negative number in the Total field and press the TAB key. If the 
Taxable check box is selected, the Tax Sub and Tax are calculated.  

3. Click Update & Post. A credit memo is posted to the account. This takes care of adjusting sales and tax 
on sales, but cash is not yet affected.  

4. Select AR > Post Payments and select the account. The credit you just posted will be at the end of the 
list of open items.  

5. Select the credit memo.  

6. Select the type of refund in the Remainder field (on account, return cash, and so on). This indicates 
that the entire credit memo is to be returned to the customer and identifies how it is being returned.  

7. Click Update & Post. The amount of the credit memo is removed from the cash drawer.  
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Adjusting sales categories  

If you discover that a charge was posted to the wrong sales category, you must create a zero-balance journal 
entry that moves the amount to the correct sales category. EFI recommends that you create an “in house” 
account to use for these types of transactions to avoid cluttering up customer histories with housekeeping journal 
entries. If you do not want to create a customer account for this type of transaction, you can use the walk-in 
account.  

For example, if $100 was charged to the HP 5000 sales category instead of the VUTEk sales category, you 
would make the following journal entry:  

1. In the Journal Entry window, click Select Customer and select the “in house” account to use for the 
transaction.  

2. In the HP 5000 field, enter -100.  

3. In the VUTEk field, enter 100.  

4. Click Update & Post.  A zero-balance journal entry is recorded.  

The sales report shows this as a $100.00 decrease in the HP 5000 sales category and a $100.00 increase in the 
VUTEk category, with no other effect on sales.    
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Register Tape 
 

PrintSmith Vision keeps a detailed record of all transactions for each sales “day” on an electronic register tape. A 
sales day ends when you perform a closeout, and a new tape is started. The register tape records significant 
events such as deposits, document voids, posted payments, finance charges, and journal entries. When you 
post transactions in the Cash Register window they are recorded on the register tape.  

If you are using line-item taxation and a transaction involved more than one tax table, all the tax tables are listed 
in square brackets, but the Tax amount is the total tax (the amount is not broken down on the register tape). 

Voiding entries on the register tape  

Occasionally, people make mistakes: they select the wrong invoice for posting, enter a check as cash, and so 
on. Sometimes a customer may change his or her mind about a purchase or ask for a refund. When this 
happens, you want to be able to correct the problem quickly. In PrintSmith Vision, you can adjust your 
accounting records in two ways: you can make a journal entry or you can void the transaction on the register 
tape. Whenever possible, EFI recommends that you void the transaction on the register tape.  

After you perform a closeout, the register tape for that period is locked. As a result, you should review the tape to 
determine if any transactions need to be voided before performing a closeout. It is much easier to void the 
transaction before the closeout than to create a journal entry afterwards. A journal entry does not cancel the 
transaction; it creates a new transaction that counteracts or reverses the original transaction. A journal entry can 
sometimes be difficult to set up and it is subject to the same kind of errors as the original transaction. For 
information about journal entries, see 99.  

When you void a transaction, on the other hand, a new transaction is not created except to record the void itself. 
For example, if you void an invoice pickup transaction, the invoice is removed from the account history and 
placed back in the pending invoice list just as though it had never been picked up.  

Voids are not allowed in a few situations:  

• Deposit entries. To remove a deposit, open the invoice and use Invoice > Deposit Entry to zero out all 
the deposit information.  

• Invoice cancellations. Once an invoice is canceled, the data in the invoice is gone – there is no way to 
recover it, so no way to void a cancellation.  

• Voided entries. You cannot void an entry that was already voided, or an entry that records a void.  

• Invoices or payments that were already paid or applied in a later transaction. PrintSmith Vision will 
notify you of the problem and identify the entry that is at fault. For example, if you pick up an invoice and 
later use AR > Post Payments and apply the payment, you cannot void the invoice pick up until you 
void the payment.  

• POS charges. You cannot void charges that were posted using AR > Post POS Charges.  

Note  You can only void transactions if you have permission to do so. 

To void a transaction, select it and then the VOID button will be active and you can use it (if you have 
permission). Once the transaction has been voided it will have a line drawn through it and a new entry will be 
added that a transaction has been voided. This is the recommended way to correct mistakes; once a closeout 
takes place, you must make journal entries to correct mistakes, which can be more complicated to set up.  
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 You can also print the tape register by selecting that feature. Since register tapes can be quite long you can also 
search using the standard search at the top of the screen. You can search by date or date range, ID number, 
price or total. 

Opening old tapes  

As part of a daily closeout, the register tape for that period is archived and locked, and a new tape is started. You 
can use the Old Tape button to open register tapes from previous closeouts (identified by date). While you can 
review and print any tape, you cannot void entries in old tapes because they are locked after a daily closeout. 
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Closeout 
A closeout in PrintSmith Vision is the process of summarizing the sales and accounting activity for a day or 
month.  

What do “daily” and “monthly” mean?  

Daily closeout  

Despite the name, how you define “daily” is up to you. You pick the frequency.  

• Daily does not need to correspond to a 24-hour calendar day.  

• The period represented by a daily closeout can span several days, e.g., every Wednesday.  

• More than one daily closeout can be performed during a 24-hour period.  

 

Monthly closeout  

Despite its name, a monthly closeout can be run at any time, but typically you would do this at the end of a 
calendar month. The monthly closeout just summarizes the daily closeouts.  

What to avoid  

• The longer the period between daily closeouts, the harder it can be to track down discrepancies – the 
volume of transactions will be higher.  

• The period represented by a daily closeout should never span the end of the month, e.g., if a daily 
closeout was run on April 28, do not run the next one on May 2 – this will distort your monthly figures.  

 

Manual vs. automatic closeouts  

Closeouts are typically performed manually (as described below), but you can also automate the process. For 
information and recommendations about automatic closeouts, see page 106.  

NOTE Auto closeouts do not allow for a review of detail reports. 

Manual closeouts  

Closeout checklist  

1. Post POS charges 
2. Start daily closeout: new vs. append. 
3. (Optional) enter productivity data. 
4. Balance cash drawer. 
5. Look at sales summary.  
6. Run trial closeout to verify numbers. Trial closeout will lock everyone out of the system. 
7. Verify sales summary report against invoice pickups, payments, journal entries, and tax  
       summary.  
8. Run real daily closeout. 
9. As needed, run monthly closeout. 

         
 Details of these tasks follow.  

Task 1: Post POS charges  

If you charged any cash register transactions to accounts, post those charges before starting a closeout:  

1.    Select AR > Post POS Charges.  

       2.    Select the options you want (for example, Print Summary Report) and click OK.  
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Task 2: Start daily closeout  

1. Click on Accounting on the left panel > AR > Closeout 
2. Select Trial closeout or Daily closeout. EFI strongly recommends you always run a trial closeout before 

doing a “real” closeout – this gives you the opportunity to review various closeout reports and correct 
any discrepancies if necessary. Trial closeout also allows you to just select the reports you want to see 
by checking the box Quick Trial Close. If you do not check that box, then the rest of the closeout 
process is the same for Trail or Daily. 

3. Select one of the following:  

• New closeout for today – always select this unless you are doing more than one closeout during 

the same calendar day.  

• Append to closeout – select only if you are performing more than one closeout during the same 

calendar day (this can be useful if you have multiple shifts and want to close out each shift).  

After selecting the type of closeout then you have the option to “Capture Productivity Data”. There are four 
steps to the closeout process. 

1. Productivity Data (Optional) 

2. Balance Cash Drawer 

3. Review Sales Summary 

4. Verify Reports 

Automatic closeouts  

Instead of performing daily or monthly closeouts manually, you can have closeouts performed automatically – 
without any user interaction – at a time of your choice.  

Before you begin: important recommendations and notes  

• Monthly closeouts: EFI recommends doing automatic monthly closeouts to ensure your monthly totals 
are captured at month’s end. For example, if you are travelling, or if the end of the month falls on a 
weekend or holiday, an automatic monthly closeout ensures the closeout always takes place.  

• Daily closeouts: EFI does not recommend automatic daily closeouts for normal use because you have 
no opportunity to balance the cash drawer by counting cash or credit cards, reviewing deposits, and so 
on. In general, manual daily closeouts are recommended. Automatic daily closeouts can be useful, 
however, if you cannot always be there to perform the closeout manually but want to make sure the 
closeout takes place regularly.  

 

Note An automatic daily closeout will take place only if the register tape has items on it. If you perform 
manual daily closeouts on most days, and the register tape is empty, automatic closeouts will not take place on 
those days.  

If the system finds discrepancies in the cash drawer during an automatic daily closeout, the closeout will fail, and 
you will need to perform a daily closeout manually to correct the problem(s). For this reason, if you frequently 
correct discrepancies in the cash drawer during manual daily closeouts, automatic closeouts are not a good 
solution for you.  

Activating automatic closeouts  

To take advantage of automatic closeouts, you must activate them in the PrintSmith Vision Closeout 
preferences.  

1. In PrintSmith Vision, click Preferences in the Quick Access panel (or select Admin > Preferences).  

2. Under Accounting, select Closeouts.  

3. Select the Activate Auto Closeout check box.  

4. To perform daily closeouts automatically, select the Perform daily closeout automatically check box 
and then select a Time of Day. (The default time is 20:00.)  
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5. To perform monthly closeouts automatically, select the Perform monthly closeout automatically check 
box and then select a Time of Day. (The default time is 23:00.) Automated monthly closeouts always take 
place on the last day of the month. 

  6. To ensure some members of your organization are informed if a closeout fails or is interrupted, enter:  

• Failure Notification E-Mail Addresses (separated by ;)  

• Subject Line of e-mail that is sent  

• Body Text of e-mail that is sent  
 
Important  For e-mail to be sent, you must have e-mail enabled and configured in PrintSmith Vision. For 
information, see “E-Mail preferences” in the PrintSmith Vision – Setup and User Guide.  

7. Click Save.  
The daily and/or monthly closeouts will now take place automatically at the time you specified. 

  

Closeout warnings  

Users who are logged into PrintSmith Vision are given a 15-minute warning that an automatic closeout is about 
to begin so they can finish their work and log out. If they remain logged in, their session is suspended until the 
closeout is done.  
In addition, if users try to log in while a closeout is taking place, they will be prevented from doing so.  

Automatic daily closeouts  

Note the following about automatic daily closeouts:  

• A daily closeout will only take place if the register tape has items on it.  

• If a daily closeout already occurred on a calendar day (typically due to a manual closeout), the automatic 
daily closeout will be appended to the previous closeout.  

• If the system finds discrepancies in the cash drawer during an automatic daily closeout, the closeout will fail, 
and you will need to perform a daily closeout manually to correct the problem(s).  

 

Automatic monthly closeouts  

An automatic monthly closeout will take place only if the register tape is empty. If it is not empty, the system 
automatically performs a daily closeout before the monthly closeout.  

Status of automatic closeouts  

A history of all your automated closeouts is available under History in the Closeout preferences. Here you can 
see what type of closeout was performed, when it was performed, and whether it was successful.  

1.    Click Preferences in the Quick Access panel (or select Admin > Preferences).  
2.    Under Accounting, select Closeouts.  
3.    Check the History. (Click Refresh to update the results.)  

In addition, if a closeout failed, and you specified one or more Failure Notification E-Mail Addresses in the 
Closeout preferences (and have e-mail enabled and configured in PrintSmith Vision), those users will be notified 
by e-mail. Typically, they will need to correct problems by performing a manual daily closeout. 

Closeout reports  

No closeout reports are printed when an automatic daily or monthly closeout takes place, but those reports and 
deposit tickets are available from the Reports menu for viewing and printing later: Reports > Daily Sales, 
Reports > Monthly Sales, and Reports > Deposit Ticket. 

Closeout Steps 

Productivity Data 

You can enter the productivity data if you want to track productivity statistics. 

• Square feet in Store: your square footage. This is used to calculate sales per square feet.  

• Number of Workers: the number of employees. This is used to calculate sales per employee.  

• Press Hours Worked: the number of billable hours for all your printers.  

• Other Prod Hours: other direct labor hours such as setup and finishing.  

• All Other Hours: other hours worked that are not related to production. This would normally 
include sales and supervisory hours. 
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Balance the Cash Drawer 

Important  The process of balancing the cash drawer is the single most important verification procedure you 
perform in PrintSmith Vision. Never finish a closeout if the Balance Cash Drawer window has unexplained 
discrepancies. 

Count cash  

Count all the cash you have on hand. This amount should match what is shown in the Cash in Drawer field.  

PrintSmith Vision automatically subtracts the amount in the Change Fund field from the amount in the Cash in 
Drawer field and displays the total cash to deposit in the Cash to Deposit field. This amount is also shown on 
the right side of the window so all the deposit totals are in line.  

Note You cannot finish a closeout if Change Fund is larger than Cash in Drawer. Since Change Fund is the 
amount of cash held out of the deposit, you cannot have more in the drawer than you actually have. You must 
make sure the change fund does not exceed the cash in the drawer.  

Common problem:  

You have less in the Cash in Drawer field than is shown in the Change Fund field.  

A returned deposit almost always causes this problem. If you return a deposit made with a check that was posted 
on a previous day, the check is no longer in the cash drawer. When this happens, PrintSmith Vision issues a 
cash refund because it no longer has the check to return to the customer. Often, you will have issued a business 
check for the refund, and this causes the discrepancy.  

A discrepancy can also occur if you entered a check while posting payments for more than the total selected for 
payment and did not apply the remainder to the account. In this case, PrintSmith Vision issues a cash refund to 
the customer instead of crediting the remainder to the account.  

Solution:  

Review the register tape (POS > Open Tape) to find the problem and correct it. Look for Refund - CASH in 
transaction records on the register tape. 

Count checks and drafts. Checks and drafts are shown in the deposit item list (at the top of 
the Balance Cash Drawer window) in the same order they were posted.  

• Verify that each item in the list matches an actual check. (Alternatively, add up all the checks on hand 
and compare this to the amount shown for Checks in the Balance Cash Drawer window.)  

• If you have checks on hold or on automatic release, keep them separate so they are not part of your 
verification.  

Handle refund checks  

When posting payments, you can issue refunds by writing a check. In this situation, only half of the transaction is 
completed in PrintSmith Vision. The check itself is not written in PrintSmith Vision so the record of a refund check 
in PrintSmith Vision is just a reminder that a check must be written to complete the transaction.  

Count credit cards  

Credit cards are slightly different from checks and drafts. Typically, the credit card processing system issues a 
summary report with transaction counts and totals for each type of card. For a summary of charges for each 
credit card, click the button to the right of the Credit Card total in the Balance Cash Drawer window. 

Note  Credit card transactions that are on hold are not included in this window. Keep these transactions 
separate.  

Add checks  

Balance Cash Drawer window).  
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Warning  Checks added this way are included only on the deposit ticket, and almost always result in a 
variance in your daily sales report unless offset by a change in cash. EFI strongly recommends you fix the 
transaction that caused the problem rather than add a check.  

Added checks are placed at the end of the list in the Balance Cash Drawer window with the word Add in the 
Status column.  

Change checks in deposits  

You can change the reference number or amount for a check if necessary (by selecting a check in the Balance 
Cash Drawer window and clicking Change Check in Deposit).  

Warning  A change to the reference number or amount of a deposit affects only the deposit ticket, and 
almost always results in a variance in your daily sales report unless offset by a change in cash. EFI strongly 
recommends you fix the transaction that caused the problem rather than change a check.  

Hold or release checks  

To place a check on hold or to release a check so it is included in the deposit, select the check in the Balance 
Cash Drawer window and click Hold/Release Check. Items on hold have Hold in the Status column. They are 
not included in the deposit total on the deposit ticket. On subsequent closeouts, they are included in Items on 
Hold.  

Correct discrepancies  

If there are any discrepancies, identify them and fix the problems before continuing with the closeout. Click 
Cancel in the Balance Cash Drawer window to cancel the closeout.  

Typically, once you identify an incorrect transaction, you must use POS > Open Tape to find and void the 
transaction and then you must re-enter the transaction correctly.  

Note Always void the most recent transactions first.  

When trying to identify discrepancies, watch out for:  

• The amount on a deposit item differs from the amount in PrintSmith Vision. Always fix this 
situation. Find the transaction on the register tape and void it. Then enter the transaction again with the 
correct amount. Although you can modify the reference number or amount of any transaction, avoid 
doing this because it almost always introduces accounting errors.  

• Payment type totals do not match. If the total of all payment types in PrintSmith Vision does not 
match all of the payments in the cash drawer, payments of the wrong type were probably entered. For 
example, if cash is over by $100 and checks are under by $100, a payment was probably recorded as 
cash instead of being recorded as a check. To fix this problem, identify the faulty payment, void it, and 
re-enter it as the correct type of payment. EFI strongly recommends that you always fix this type of 
problem to maintain a strong audit trail.  

• Extra check, credit card, or draft in hand - You probably forgot to post a payment in PrintSmith Vision 
or forgot to enter a deposit on an invoice. If one of the other payment types is too high, a payment or 
deposit may have been entered with the wrong payment type. Look for a transaction with a different 
payment type that matches the amount on the check or draft. Void the transaction and re-enter it with 
the correct payment information. If it is a deposit, open the affected invoice, change the type of the 
deposit, and save the document.  

• Extra check or draft in PrintSmith Vision. If all the other payment type totals are correct, a payment 
was made that should not have been made. The information in the list of deposit items will help to 
identify the incorrect transaction. Most of the time, this is a pickup or POS charge that was paid for in 
PrintSmith Vision when it should have been charged to the customer’s account. Void the transaction 
and then charge it to the customer account.  

• Cash in hand is too high. Unless this is your very first closeout, and beginning cash was not entered 
in the Change Fund field, you probably forgot to enter a payment or a deposit.  

• Cash in hand is too low - If cash or credit cards are correct, you probably entered a cash payment in 
the cash register that should have been a charge or entered a cash deposit when one was not made. 
Alternatively, you entered the wrong payment amount. If cash or credit cards do not match, find those 
mistakes first. If cash is still off, look for the mistakes in cash transactions. Void the incorrect transaction 
and re-enter it.  
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Review Sales Summary 

After you click NEXT STEP in the Balance Cash Drawer window, the Daily Sales window opens. This includes 
the A/R Balance – this is the original balance (from the last closeout) minus payment plus new charges adjusted 
by any journal entries.  

Note  Although you can review the contents of this window, it is more important to compare the contents 
of certain reports during a trial closeout. 

Verify Reports 

Here you can select the reports that you want to see. At a minimum you should select the following reports. 

• Sales Summary 

• Invoice Pickups 

• Payments 

• Journal Entries 

• Tax Summary 

The reports that you selected open in a preview window, from which you can print them.  

Verify the Sales Summary report against the Invoice Pickups, Payments, Journal Entries, and Tax Summary 
reports.  

If you find discrepancies, correct them. If everything is correct, continue to the real daily closeout. 

When you select “Finish Trial Close” the reports that you selected will be displayed on the screen where you 
have the option to print or download them. 

The daily closeout will take you through the same steps as the trial closeout except that you do not have the 
option for Quick Trial Close. 

• The daily closeout does the following:  

• Adds an entry to the register tape indicating that a closeout was performed. 

• Archives the current register tape and creates a new register tape. The archived tape is locked so it 
cannot be changed, but you can use Reports > Open Old Tape to review an archived tape.  

• Resets the cash drawer. Cash is set to the amount in the Change Fund field. Checks are set to reflect 
any checks on hold. Credit cards are zeroed. AR balance is unchanged.  

• Updates the daily sales summary. This summary includes information about new invoices and invoice 
pickups, as well as tax details.  

• Saves a copy of the deposit ticket.  
Tip   To print a deposit ticket after a closeout is done, select Reports > Deposit Ticket. In the 
Deposit Ticket window you can select a deposit ticket (identified by the date of the closeout) and then 
preview and print the Daily Deposit Record. You can also select multiple deposit tickets in the Deposit 
Ticket window and then click Select to generate a report that includes a Daily Deposit Record for each 
of the deposit tickets you selected.  

• Opens each of the closeout reports you selected in a preview window from where you can print them.  

 

Monthly Closeout 

A monthly closeout provides a summary of the sales for a calendar month and updates customer sales statistics 
and account histories. The system automatically figures out which month needs to be closed out next and 
informs you what it is going to do. You do not have to enter anything except the optional productivity data.  

Although typically you will perform a monthly closeout at the end of a month, you can do so at any time. If a 
closeout was already done during the current month, PrintSmith Vision updates the monthly sales figures instead 
of starting a new month.  
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Note  Monthly closeouts are currently done in the Legacy version and will lock everyone out of the 
system. 

To perform a monthly closeout  

1. Go to Legacy UI 
2. Click Accounting > AR > Monthly Closeout. 
3. Before starting the closeout, PrintSmith Vision informs you what period is being closed out. Click 

Continue to review the productivity information and change it if necessary. 
4. When the Monthly Sales window opens, review the information and then click Continue. \ 
5. In the Closeout Reports window, select the reports you want to print. Click Trial Closeout to 

perform a trial closeout or Finish Closeout to complete the monthly closeout.  
6. The reports that you selected open in a preview window from where you can print them. \ 
7. Check the Total in the Sales Summary report as follows:  

• Take the Total from the Invoice Pickups report.  

• Subtract the Total from the Journal Entries report.  

• Add the POS sales (open each daily tape for the month and manually add up the totals).  

 

The result should match the Sales Summary Total.  

8.  When the closeout is finished, you are asked if you want to update account history with sales 
statistics. Click OK if this is the “final” closeout for the month.  

Tip  Updating sales statistics can be time-consuming so you can skip this step if you know this is not the last 
closeout for the month. 
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Pending Documents 
 

The Pending Documents window is a “command center” for managing your active documents. These are all 
the invoices that are in production or are waiting to be picked up as well as all the estimates that were not 
voided (canceled), archived, or converted to invoices. You can control which columns are displayed in the 
Pending Documents window and the order in which they are displayed, as well as the colors that identify 
certain kinds of information.  

        

The Pending Documents Window 

 

 

The Pending Documents window has four tabs across the top that you can use to select which documents you 
want to see or you can select to see all documents. The documents can be identified by the icon on the tab and 
to the left of the account. Each tab will also display the number of documents in each category. 

Tip   The number of web orders is not included in the total number of invoices. 

You can filter further, regardless of the tab you are using, by selecting the TYPE dropdown. 

 

 

Each user can determine which columns are displayed, number of days of estimates to display and the color 
indicator for invoices and estimates at different stages. 
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Each column can be sorted high to low or low to high by selecting it. Or if you are looking for a specific 
invoice/estimate you can just enter the information in the appropriate field. You can click and drag columns to 
change the layout.  Note also that the wanted date now includes time. 

  

 

If you are looking for something within a specific date range, you can enter the date range by selecting the 
starting date and then the ending date. If you are looking for a specific date the starting and ending date selected 
will be the same. 

Tip    Only click once when you select the date, do not double click 
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You can clear all filters 

 

 

You can access the job contained in an invoice or estimate by selecting the > to open the detail. 

 

You can change the location of each job. The location for the estimate/invoice will reflect the latest location that 
was changed for a job. When you change the location of the estimate/invoice that location will be reflected in 
each job. You can add job comments 

 

 

 

You can change the wanted date of an estimate/invoice 

Selecting the document number will take you to the estimate/invoice where you can make changes if needed. 

The three-dot symbol will show you other options. Those options are different for each tab. 
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Estimating options 

 

Open in new tab will open the estimate/invoice in a new tab for modification or review. 

Convert to Invoice will convert the estimate to an invoice and take you to the invoice screen. 

Notify Customer will allow you to create an activity to notify the customer. 

 

You can choose from pre-defined activities and a note will be added to the customer account log. 
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Follow-up required gives you the opportunity to enter a follow up date and who is to follow up. You can also enter 
follow-up comments. 

       Completed allows you to enter the date complete, completed by and the action taken. 

       You can email directly from this screen. 

Hold estimate will allow you to select the reason for the hold     

Note The next time you open this option after putting the document on hold you will have the option to 
release the hold. 

                                                                                              

 

Lost estimate will allow you to identify the reason for the loss. 

 

If you select other reason you can enter comments below. 

You can also print or archive the estimate. 

Archive Estimate will remove it from Pending Documents. 

For invoices some of the options are the same but there are some specific to invoices. 
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Pickup Order takes you to the Cash Register program. You can pick up more than one order, but they must all 
be for the same account. 

Note  When you click Pick Up, PrintSmith Vision checks whether the tax rate on the invoice is current. If 
the rate changed since the invoice was last opened, you are warned that the tax is incorrect. If you receive this 
warning, open the document, check the tax (which is recalculated when the document opens), and save the 
document before picking it up. You can ignore the warning and pick up the document, but the sales tax will be 
incorrect. 

Release for Pickup changes the status to ready to pick up. 

You can print the invoice or job ticket 

You can also void an invoice. If the invoice has a deposit on it, you will be notified and asked if you want to 
refund the deposit. 

If you select Yes, then the amount should be returned and in credit card manager the amount will be voided. If 
user says No, then the deposit will be FORFEITURE 
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Web Orders 

 

Under Web Orders you can also produce a delivery ticket and shipping label. 

 

You can enter the weight, delivery date and tracking number. For more information on delivery ticket see page 
84. 

Using the label icon, you can print a shipping label.
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Work in Progress (WIP) 

 

Work in Progress contains all the jobs that are waiting for processing. You can choose to display jobs or 
documents. A document may contain more than one job. You can use the heading to filter out certain jobs based 
on the headings as well as have them sorted in ascending or descending order. You can use click and drag to 
change the position of the column headings. Each job or document will be displayed in the color that matches the 
status. (See customizing the list to set the color) 

 

The screen shot above is displaying documents. If you select jobs, then you will see a different layout. Additional 
tabs will be displayed. If you are using Fiery and you have jobs assigned to Fiery then the Fiery Integrated tab 
will be visible and you can select for those jobs. 

 

You can print out the WIP list as a csv file using the “Download as CSV” icon. 

If you select the “Download as pdf icon you will see the different print options you have. 

 

• Print with extra space will add a blank line after each row in PDF 

• Print with Job Comments will add job notes after each row in PDF 

• Repeat Headers will repeat the column header on each page if generated PDF have multiple pages 

• Open PDF in new tab will open the PDF in new tab instead of showing the download option  

• The user has the option of selecting a standard paper size or selecting custom and entering in the width 
and height. The units field is used to select the units for the entered width and height. 

• You can also select the orientation and scale to be used in the PDF 
 
Selecting the “Customize List” option you will get a short cut menu screen where you can change the columns to 
display, identify the color for each item based on its status and set up other filter options. 
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There are different column options depending if you are displaying jobs or documents. You can determine if you 
want to include estimates or not. You can set up additional filters here also. You can set up a filter based on the 
order price you enter. You can also set up filter for order where you have received the deposit and determine if 
you want to include shipping and tax amount in the displayed totals. In the case of order price amount and 
deposit received with orders they become a filter you can select. If you check include shipping and tax amount in 
totals, then the totals will change to reflect that amount. 

 

In this screen you can also determine the color you want to use to identify the different statuses of the jobs. You 
can enter a specific hexa decimal color code or you can select the color field and select the color that way. 
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The documents are color coded according to the guide 

 

By using the drop down, you can filter the jobs you can display based on their status or a saved filter 

 

Once you have created a filter you can save and use it later. 
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In this example a filter was created for a particular customer, Australian Turf Club. 

Selecting “Save Filter” gives a short cut menu where you can name the filter 

 

This filter now becomes available in the search 

 

Selecting “Manage Filters” allow you to modify or delete the saved filter 

 

You can clear the filter 
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Hovering the mouse over the document title will show more detail about the job. Double clicking on the document 
title will take you to the job details screen for the invoice. 

 

 

Once you select one or more documents or jobs you have other options depending on which screen and which 
tab. 

On the documents screen you can print job tickets. Selecting this option will print the job ticket(s) for the jobs in 
the document. 

 

On the jobs screen under both the All Job or the Fiery Integrated tabs you have these options 

 

Print job ticket will print the job ticket to the screen where you can determine where you want the document to 
print. 

Select users to Assign gives you the option to assign a user to the job. 

The next field will display the options of where the job can be processed. The column “Device ID” will display the 
device ID. 

Note This is only available on the job screen display 

 

 

The submit to Fiery field will allow you to submit the job to fiery.  
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The options displayed under the tabs works well when you are working with multiple jobs but you also have 
options available for each job. Assign job, Submit to Fiery and print job tickets work just like the above options. In 
addition to those you can, mark the job as outsourced and notify the customer. 

Note If the job has already been submitted to Fiery, that option changes to Void Fiery job which will 
cancel the job in Fiery. 

 

You can mark the job as outsourced by moving the sliding dot. This will cause the job to be marked as 
outsourced and change the number of jobs in the outsourced total. 

Note Marking a job as outsourced does not change its pricing method and job price. 

 

Selecting “Notify Customer“ brings up a box that shows all of the current activities and the ability to add an 
activity. 

 

 

When you select Add New you will be shown a place to enter a new activity 
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PO History 
 

The PO history process allows you to view all purchase orders including completed purchase orders and the 
current status of the purchase order. 

 

 

You can filter purchase orders by selecting a vendor, date range or status using the column headers.  Selecting 
this icon will clear the filters and list all purchase orders. 

 

 

Checking the box “Show Completed” will add completed purchase orders to the list. 

 

Double clicking on any PO number will open that purchase order. From there you can edit or change the status 
of a line or the entire purchase order. 

 

You can sort the purchase orders in ascending or descending order by using this icon. 

 

You can delete purchase orders by checking the box next to the purchase orders you want to delete and then 
selecting the delete icon. 

 

 

Selecting the plus sign allows you to create a generic purchase order that is not related to an invoice. 

1. Select the vendor 
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2. Enter the required date. Clicking on the field will display a calendar. 

3. Enter the buyer information and description. 

4. Select add a line item and complete the information on what you are ordering 

Note  The PO type is now generic 

 

 

You have the same features that you have when raising a PO in invoicing. See page 76 for information on 
“Raising a PO” in invoicing. You can edit, mark as complete or delete an item. 

 

 

You can email, print and save the PO.  

 

 

Note If you want to email to the supplier then you must include their email address in the vendor record. 
See page 16 for information on “Adding or Editing a Vendor Record”. 

 

 

 


